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ABOUT WEBCT 

WebCT Inc. is the world’s leading provider of integrated e-Learning systems for higher 
education. With WebCT, institutions can provide more convenient and personalized 
learning options for students, expand access to academic programs, and improve course 
quality.  

WEBCT CA MPUS EDIT ION 
WebCT Campus Edition™ 4.0 (hereafter referred to as WebCT CE) allows course 
designers to create an interactive learning environment that brings instructors and 
students together in a virtual classroom. This online course management solution 
combines course development and delivery tools with a comprehensive course 
administration system. With WebCT CE, you can create entire courses online or 
complement a classroom-based course. 

Use WebCT CE to: 

• provide course materials that include text, complex equations, images, video, and 
audio 

• evaluate students with quizzes and assignments 

• communicate with students via discussions, electronic mail, real-time chat 
sessions, and an interactive whiteboard 

• facilitate learning using a searchable index, glossary, and image database for each 
course  

• encourage student interaction by enabling the creation of student homepages and 
online presentations 

• share course content with other designers and institutions 

• record, maintain, and communicate grades 

• enable student self-evaluations through self tests and progress tracking 

• obtain data that allows you to analyze the effectiveness of your course 
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ABOUT THE TUTORIAL 

AUDIENCE 
The Getting Started Tutorial introduces course designers to the WebCT CE course-
building process. A course designer may be an instructor, a teaching assistant, or an 
instructional designer-anyone building a course from the designer interface of WebCT 
CE. 

This tutorial is intended for designers who have never used WebCT CE before. However, 
this guide assumes that you possess basic computer skills and that you are familiar with 
web browser navigation. 

ORGANIZAT ION 
The tutorial is divided into three parts: 

 PART ONE: GETTING STARTED introduces the WebCT CE Campus Edition 4.0 
workspace and discusses some key concepts that are central to building a WebCT CE 
course. This section should be read before proceeding to Parts Two and Three.  

 PART TWO: CREATING BASIC COURSE ELEMENTS contains three lessons. The 
first lesson is directed at creating a central web page for your course. The next two 
lessons explain how to add course content. Each lesson is a stand-alone unit. 

 PART THREE: ADDING COMMUNICATION AND EVALUATION TOOLS contains 
two lessons directed at adding course elements that allow the exchange of information 
between WebCT CE users. A third lesson is directed at adding a course element to 
evaluate your students’ progress. Each lesson is a stand-alone unit.  

Although the lessons in Parts Two and Three can be completed in any order you choose, 
you’ll gain a better understanding of the course building process by progressing through 
the tutorial in the order in which it’s presented. 

REQUIREMENTS 
Before you begin the tutorial, your WebCT CE administrator must create an empty 
course, called Introduction to Internet Communication, in which you have designer 
access. This tutorial walks you through the process of adding tools and course content to 
that empty course.  
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If you haven’t already done so, contact your WebCT CE administrator and ask that a 
blank course be added to your User Record. Request that the administrator follow the 
detailed instructions found in the System Administrator’s Guide: WebCT Campus Edition 
4.0, in Chapter 3: Course Management, “Creating a Course for the Getting Started 
Tutorial.” 

TUTORIAL  CONVENTIONS 
The following conventions are used in this document: 

 
Font characteristic or symbol Description 
bold Identifies a button or text that can be clicked. For 

example:  
Click OK. 

italic Identifies a tool name, screen name, or screen element. 
This type of formatting is also used to reference another 
document or another section of this document. For 
example:  
On the Welcome screen, click Next. 

courier  Identifies text that the user enters, or has entered, into a 
field or text box. This font is also used for URLs, e-
mail addresses and filenames. For example: 
In the text box, enter: Syllabus 
http://www.webct.com 

USING THIS  TUTORIAL 
You’ll be logged in to WebCT CE while you work through the lessons contained in this 
tutorial. For ease of reference, you may want to print this document. The tutorial is 94 
pages in length. 

If you prefer to view the tutorial electronically using Adobe® Acrobat® Reader®, there are 
embedded links for your convenience. Use the links to access referenced web pages or 
other sections of this document. To return to the previous page, use Go to previous view 

 displayed in the Reader toolbar. 
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PART ONE: GETTING STARTED 
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LESSON 1: LOGGING IN AND 
EXPLORING THE WEBCT CE 
ENVIRONMENT 

Before you start creating your course, it’s best to become familiar with some WebCT 
terminology and the WebCT CE workspace. 

There are a number of screen features that are common to all areas of WebCT CE. To 
navigate quickly and efficiently through your course, it’s helpful to understand the layout 
and function of these workspace features.  

LEAR NING OBJECTIVES 
After completing this lesson, you’ll be able to: 

• explain the course building concepts that are central to WebCT 

• log in to WebCT CE and access a course. 

• identify the four main areas of the WebCT CE workspace. 

• access online Help to get more information on using WebCT CE. 

• preview WebCT CE screens to see how they appear to students. 

• explain the roles of the Course Menu and the Homepage. 

• access the Control Panel and describe the course modification options it contains. 

• navigate through your course using the Course Menu and the breadcrumbs. 

UNDERSTANDING WEBCT’S  KEY COURSE 
BUILDING CONCEPTS 
To better understand the WebCT CE course building process, you need to become 
familiar with two key concepts: links and tools. 

LINKS 
Your institution’s WebCT CE software is stored on a web server along with all the files 
for each WebCT CE course. Data such as course content and student information are not 
stored on your computer. You and your students access the WebCT server and the course 
files via a web browser, such as Microsoft® Internet Explorer or Netscape Navigator®.  
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You access a specific area of your course on the server, such as Mail or Glossary, by 
clicking a link. This sends a web page request to the server. The server responds by 
delivering the corresponding web page to your computer for display.  

Because all files reside on the WebCT server, if you want to add existing course material 
to your WebCT CE course, you must upload the files from your computer to the server. 
In the process of uploading the file, you also create a link to that file. You and your 
students access the file by clicking the link.  

The diagram below illustrates how all communication within the WebCT environment 
passes through the WebCT server. 

  

Server sends 
file for display

Server sends file 
for display 

Student clicks 
link to request 
course file 

Designer 
clicks link to 
request 
course file 

Designer 
uploads files 
to server 

Uploaded course 
files are stored 
on server 

WebCT Server

Student computer Designer computer 
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TOOLS 
You build your course in WebCT CE using tools. Each course element has its own tool. 
For example, to create the course element, Mail, you use the Mail tool.  

Before you can use a tool, you must add it to your course. For example, to create a course 
glossary, you first add the Glossary tool. This places a Glossary link on the Course Menu 
and the course Homepage. By clicking the link, you can then add content to your 
glossary. You and your students access the completed glossary by clicking the same 
Glossary link. This concept will become clearer as you work through this tutorial and add 
tools to your course.  

GETT I NG STARTED ACTIV IT IES 
There are two activities in this lesson: 

• logging in to WebCT CE and accessing your course 

• exploring the WebCT CE work environment and becoming familiar with its 
features 

LOGGING IN 
All administrators, students, teaching assistants, and designers need an ID and password 
to log in to the WebCT server and access courses. You also need an ID and password to 
complete the lessons in this tutorial. 

Your WebCT CE administrator is responsible for providing you with a URL (server 
address), a WebCT ID, and a password. If you don’t have this information yet, contact 
your administrator. 

1. Open your web browser. 

2. Enter the URL provided by your WebCT CE administrator. The URL looks 
something like this: 
http://webct.institution.edu 

The WebCT Entry Page appears. 

3. Click Log in to myWebCT. The Login to WebCT screen appears. 

4. Enter the WebCT ID and Password provided by your WebCT CE administrator. 

5. Click Log in. The myWebCT screen appears. 

Tip: myWebCT provides you with centralized access to all of your WebCT CE 
courses. Depending on administrator settings, myWebCT can also contain 
links to Announcements from your school, bookmarked URLs, and a Global 
Calendar. For more information on using myWebCT, click Help on the 
myWebCT screen. 
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6. Under Courses, click Introduction to Internet Communications. This is the tutorial 
course that your WebCT CE administrator set up for you. The Course Design Center 
screen appears. 

7. Read the description provided onscreen about this feature. Although it’s 
recommended that new designers use the Course Design Center to build a course, for 
the purposes of this lesson, click Use the Course Design Center later. (You’ll use 
the Course Design Center to perform a task in an upcoming lesson.) A confirmation 
message appears. 

8. Click OK. The course Homepage appears. 

You’re now logged in to WebCT CE and are in the tutorial course. The screen displayed 
is the Homepage. 

Homepage 
You can think of the Homepage as your course’s home base. It is the central place where 
you can place links to all your course elements. Links can appear as text only, an icon, or 
both text and an icon. You select the format that you prefer. As you progress through the 
tutorial, you’ll customize your Homepage’s appearance and add links to seven different 
course elements to it. 

You can also create specialized pages called Organizer Pages. You can use an organizer 
page to group course elements that are similar and display their links. For example, you 
can create an Organizer Page called Communications that contains links to a discussions 
area, a chat area, a mail area, and a calendar. 

For more information on creating Organizer Pages, see the Course Design Center or the 
online Help topic, Organizer Pages. To access the online Help, click Help on the Menu 
Bar. 

LEARNING ABOUT THE WEBCT CE WORKSPACE 
There are four features that are common to every screen in WebCT CE. They are: 

• Menu Bar 

• Course Menu 

• Control Panel 

• Content area consisting of the main frame and the Actions frame 

These features are identified in the screen example on the following page. 
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Course 
Menu 

Control 
Panel 

main frame

Actions
frame

Content area
 

Now, take a closer look at each of these screen elements. 

Menu Bar 
The Menu Bar contains links to myWebCT, Resume Course, Course Map, Check 
Browser, Logout, and Help.  

 breadcrumbs 

tabs 

 

The breadcrumbs show your current location in the course and the tabs indicate whether 
you’re in View or Designer Options.  
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These Menu Bar items are described below.  

Option Description 
myWebCT Returns you to the myWebCT screen.  

  

Resume Course Allows students to resume their place in the Content Module (course 
content). 

  
Course Map  Allows you and your students to view the structure of the entire 

course on one page. The course elements are links, which enable you 
to go to any place in the course from a single page. This feature 
simplifies navigation and is especially useful for courses with a large 
number of course elements. 

  
Check Browser Allows you and your students to determine if your browser is 

compatible with WebCT CE. 

  
Log Out Logs you out of the current WebCT CE session and returns you to 

the WebCT Entry Page. 

  
Help Links you to context-sensitive online help. 

  
View Allows you to see how the course appears to students. On some 

screens, View only approximates what a student sees. 

  
Designer Options Allows you to make modifications to course elements, pages, and 

content. 

  
Breadcrumbs  Shows your location in the course and provides links to previous 

screens. You can use this feature to return to the Homepage from 
almost anywhere in your course. 

Now, access one of the options on the Menu Bar. 
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To access the online Help 
1. From the Menu Bar, click Help.  

 

The online Help topic, Homepage – About appears in a new browser window.  

2. From the Help menu bar, click Help Index. The Designer Help Index appears. Links 
to information and instructions on using WebCT CE appear. 

3. Close the browser window to return to the Homepage. 

Next, see how the Homepage appears in View.  

To switch between the View tab and the Designer Options tab 
As a designer, you’ll spend most of your time in Designer Options where you can add to 
and change your WebCT CE course using options in the Actions frame. Use the View tab 
when you want to see how a screen appears to your students.  

1. Click the View tab.  

 

Click
Help

Click View 

Notice how the Actions frame is removed from the Homepage. The Actions frame is 
only for designer use. 

2. To return to designer view, click the Designer Options tab. 

Course Menu 
Like the Homepage, you can place links to all your course elements on the Course Menu. 
It is visible to designers and students. Since you haven’t started building a course yet, the 
Course Menu only contains Homepage. The green arrow ( ) allows you to toggle 
between displaying and hiding the Course Menu to change the size of the Content area. 
Using this option only affects your view of the Course Menu. Other users are not 
affected.  

If you want to change the display of the Course Menu for all users, see the online Help 
topic, Course Settings – Course Menu. To access the online Help, click Help on the Menu 
Bar. 
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The Homepage and the Course Menu both display links to other elements in your course. 
The Homepage can display icon and text links and is readily accessed from the 
breadcrumbs at all times. The Course Menu displays text links only, is accessible from 
most areas of your course, and affects the size of the Content area. As your online course 
goals become clearer, you may decide that the use of only one of these WebCT CE 
features is sufficient.  

Later, you’ll add links to both the Course Menu and the Homepage to gain an 
understanding of both methods of displaying links.  

To change the display of the Course Menu 

1. Click . The Course Menu is hidden in a drop-down box , and the 
Content area enlarges. 

2. Click . The Course Menu appears. 

Control Panel 
The Control Panel is the central location for all designer utilities and course management 
options. It is visible only to designers. In Control Panel, designers can access the 
following course design utilities: Add Page or Tool, Edit Page or Tool, Manage Files, 
Manage Course and Course Settings. 

From the Control Panel, you can do the following: 

• add pages or tools to create course elements 

• edit the content of course elements 

• update your students’ WebCT CE course content 

• add, edit, organize, and download your course files 

• manage the records of students and teaching assistants 

• track students’ progress 

• back up your course 

• change your course’s appearance and settings  
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There are two versions of the Control Panel: Basic Control Panel and Expanded Control 
Panel. By default, when you click Control Panel, the Basic Control Panel appears. 
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The Basic Control Panel contains links to utilities where you can perform the most 
common course creation and course management tasks. The Expanded Control Panel 
goes beyond the Basic Control Panel to include links to more advanced tasks.  

To access the Control Panel 
 Click Control Panel. The Basic Control Panel appears. It is recommended that new 

users use the Basic Control Panel. 

To access the Expanded Control Panel 
 Click Expanded Control Panel. 

 
Click Expanded Control Panel 

The Expanded Control Panel appears. 

Tip: Once you gain some experience using WebCT CE, you may prefer to change the 
default Control Panel to Expanded Control Panel by clicking Set as default 
view.  

For now, go back to the Basic Control Panel. 

 Click Basic Control Panel. The Basic Control Panel appears. 

 
Click Basic Control Panel 



Under the Basic Control Panel, you’ll notice a link to the Course Design Center. 

 

This gives new designers the option of using either the Control Panel to build their 
course or the Course Design Center. 

Now, return to your Homepage. 

 To return to the Homepage, in the Course Menu or breadcrumbs, click Homepage. 

Content Area 
When you first access a course element from the Course Menu or Homepage, the content 
area is divided into two sections or frames: the main frame and the Actions frame.  

The main frame is where you perform your course building tasks and where content is 
displayed to you and your students. The main frame is visible to all users.  

The Actions frame contains links to the various editing, customizing, and organizing 
options available for a particular course element. The Actions frame is visible only to 
designers.  

A Final Note about WebCT CE Navigation  
As you become more familiar with the CE workspace, you’ll discover that there’s more 
than one way to achieve a goal. You’ve already learned that you can use either the 
breadcrumbs or the Course Menu to return to the Homepage. Similarly, from the 
Homepage, you can access Add Page or Tool directly from the Actions frame, or you can 
use the Control Panel. You choose the method that works best for you.  

This idea of flexibility of use is central to WebCT. As you gain experience in using the 
WebCT CE workspace, you’ll discover the numerous ways you can customize WebCT 
CE to best suit your preferences and on-line teaching goals. 

Warning: : Avoid using your browser’s Back and Forward buttons to navigate 
through WebCT CE. Instead, use the Course Menu, Control Panel, Menu 
Bar and breadcrumbs as discussed earlier in this lesson.  

 

You’re finished Lesson 1: Logging in and Exploring the WebCT CE Environment. In the 
next lesson, you’ll learn how to plan your course. 
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LESSON 2: PLANNING YOUR WEBCT 
CE COURSE 

Becoming familiar with the WebCT CE software is important, but it is only part of the 
online course-building picture. To create a truly effective online course, you should plan 
your course by applying the same principles you use when designing a traditional 
classroom course. The difference is that your course’s purpose, content, and structure will 
be dependent on and enhanced by the capabilities of WebCT CE.  

This lesson only touches on the key points that you should consider when planning a 
WebCT CE course, but we want to stress the importance of planning. If you develop and 
implement a methodical course design plan, you can produce an effective course more 
efficiently. When you are ready to build the actual course that you’ll use at your 
institution, you may find it helpful to seek additional resources to assist you. WebCT 
resources can be found at www.webct.com/quickstart and 
www.webct.com/ask_drc 

LEAR NING OBJECTIVES 
After completing this lesson, you will be able to: 

• describe the three key areas that you need to consider when planning an online 
course. 

• locate additional resources to assist you in planning your WebCT CE course. 

UNDERSTANDING ONLINE  COU RSE BUILDING 
BASICS 

DEFINING YOUR COURSE GOALS 
Your first step in the course planning process is familiar to you. You should determine 
the desired learning goals for the course. As in the planning of a traditional classroom 
course, you want to establish what a student should know and be able to do as the result 
of their experience in your course. For the most part, the goals of an online course are 
identical to those of a course taught in a classroom setting. You may discover however, 
that the use of WebCT CE provides the opportunity for your students to gain some skills 
and experiences that they would not gain in a traditional course. You may want to 
consider these when you are developing your course goals. 

15 

http://www.webct.com/quickstart
http://www.webct.com/ask_drc


USING WEBCT CE TO ACHIEVE YOUR GOALS 
Once you have determined your course goals, you determine how you can achieve those 
goals using WebCT CE.  

If you are using WebCT CE to supplement a classroom course, you should determine 
which goals could be achieved with the best results by using a component of WebCT CE. 
If you are creating a truly web-based course, you strive to achieve all of your course 
goals with WebCT CE. In this case, you determine which tools to use to achieve each 
goal.  

In both instances, you should have an understanding of all the components of a WebCT 
CE course. Appendix A: WebCT Course Tools on page 80 contains a table that provides a 
brief description of each WebCT CE tool and how the tool can be used. Use the table to 
select the tool or tools you can use to achieve each course goal. 

An example of a course goal for a first year English course is provided below. The 
WebCT CE tools that might be used to assist in achieving this goal are also provided. 

 
Course Goal WebCT CE Tools  
As the result of reading, analyzing, and 
discussing the literary works of published 
writers, students will be able to subjectively 
evaluate their own writing. 

• Content Module – for reading 
literary works 

• Discussions – for discussing and 
analyzing literary works 

• Chat – for discussing and analyzing 
literary works 

• Assignments – for submitting writing 
samples and critiques of writing 
samples 

• Student Homepages – for presenting 
writing samples for others to 
evaluate 

To create an online course that adds value to each student’s learning experience, it is 
essential that you understand how to use WebCT CE to meet your course goals. 

ORGANIZING YOUR MATERIALS 
Your next step is to decide what course materials to put online and to organize them. In a 
web-based course, all materials are online. However, if you’re supplementing a 
classroom course, consider your course goals when deciding which course materials to 
put online. 

It’s a good idea to create a content outline to organize these materials before you upload 
them to the WebCT server. You may want to divide them into chronological lessons or 
units to correspond with classroom lectures, or group them according to subject matter. 
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If you are going to enhance your course 
with online communication elements 
such as a discussions forum or a chat 
area, coordinate the use of these course 
elements with each unit of study. For 
example, you may want to schedule a 
weekly chat session where students can 
discuss issues related to the material 
covered that week. In addition, if you are 
creating quizzes, surveys, self-tests, or 
assignments in your WebCT CE course, 
organize the content and their schedule 
as well. 

What file format can I use? 

Course content files that use Text (.txt) and 
HTML (.html, .htm) file formats are 
recommended. These formats can be edited 
in WebCT CE and all users can view them 
within their web browsers. File formats, such 
as .doc (Microsoft® Word document) and 
.xls (Microsoft® Excel spreadsheet) among 
others, can also be used in your online 
course. However, users must have the 
corresponding software, such as Microsoft 
Word or Excel, installed on their computers 
to view these files.  

SAMPLE COURSE DESIGN SCENARIOS 
The following scenarios suggest the creation of four possible online courses that 
incorporate the content of this tutorial. They vary in purpose and complexity according to 
the scenarios outlined. They are provided here to demonstrate the course design 
principles described in this lesson and to illustrate how WebCT CE can be used to 
enhance any course. 

Note: This tutorial is designed to be a flexible learning tool. Although we recommend 
that you complete all lessons, and complete them in the order in which they are 
presented, Lessons 3 to 8 are stand-alone units. If you find that one of the 
scenarios listed below matches your online course goals, feel free to concentrate 
on those lessons first. You can return to the tutorial at any time to complete the 
remaining lessons. 

 
Scenario Suggested WebCT 

CE Tools  
Tutorial Lesson 

You are new to using the Internet to 
teach. You want to ease yourself and 
your students into online learning, 
and use WebCT to complement your 
regular classroom sessions.  

• Syllabus 
• Calendar 

Lesson 4: Adding a Syllabus 
Lesson 7: Creating a Course 
Calendar  

You want to create areas for students 
to pose questions, discuss ideas, 
analyze information, and synthesize 
concepts.  

• Discussions 
• Chat 

Lesson 6: Communicating with 
Your Students 

17 



Scenario Suggested WebCT 
CE Tools  

Tutorial Lesson 

You want to supplement your 
classroom course by providing access 
to some course materials online. You 
also want to promote individual 
learning and provide immediate 
feedback so students can gauge how 
well they are doing.  

• Syllabus 
• Content Module 
• Quizzes/Surveys 

Lesson 4: Adding a Syllabus 
Lesson 5: Adding Course 
Content 
Lesson 8: Creating a Quiz for 
Your Students 

You want to take full advantage of 
WebCT CE’s most common tools to 
enhance the learning experience of 
your students. You want to create 
areas for the presentation of course 
content, the analysis and discussion of 
course content, and the evaluation of 
each student’s understanding of that 
course content. 

• Syllabus  
• Content Module 
• Discussions 
• Chat 
• Calendar 
• Quizzes/Surveys 

Lesson 4: Adding a Syllabus 
Lesson 5: Adding Course 
Content 
Lesson 6: Communicating with 
Your Students  
Lesson 7: Creating a Course 
Calendar 
Lesson 8: Creating a Quiz for 
Your Students 

 

You’re finished Lesson 2: Planning your WebCT CE Course. You’re now ready to build 
a WebCT CE course.  
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PART TWO: CREATING BASIC 
COURSE ELEMENTS 



LESSON 3: CUSTOMIZING YOUR 
HOMEPAGE 

The Homepage is the first screen that your students see when they enter your course. It’s 
created automatically and can serve as your course’s main Organizer Page providing 
links to all other WebCT CE course elements. As a designer, you can add, remove, and 
reorganize these links using the various link options available on the Homepage.  

You can also customize the appearance of your Homepage. You can add text or graphics 
to the page or change the color scheme to better complement your course.  

LEAR NING OBJECTIVES 
After completing this lesson, you’ll be able to: 

• explain the role of the Homepage in your course. 

• describe the role of the Course Design Center in the course-building process. 

• create a heading for your Homepage using the Homepage Wizard.  

• add text to your Homepage to customize its appearance. 

• change the color scheme of the Homepage to best suit your needs. 

• refer to the online Help to get more information about other Homepage options. 

HOMEPAGE ACTIV IT IES 
There are two activities in this lesson: 

• adding a heading to your Homepage using the Homepage Wizard 

• changing your Homepage colors 

ADDING A HEADING TO YOUR HOMEPAGE USING THE 
HOMEPAGE WIZARD 
In this first activity, you’ll use a course design wizard to add a heading to your 
Homepage. The wizards assist new users and provide step-by-step instructions on using 
some of the more common course building tools. There are eight wizards in all. They are 
stored in the Course Design Center. 
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Note: Depending on administrator settings, the Course Design Center, or some of the 
wizards, may not be available to you in the course you’ll be teaching at your 
institution. 

Here’s an example of a wizard screen: 

 

 

 

Using the wizards 
When using any of the wizards, read and 
follow the text in the Instruction box 
(see the example above). All areas 
relating to the wizard are indicated in 
blue, while the rest of the screen is gray 
and temporarily unavailable.  

Look for the small wand icon: . It 
accompanies each screen element that 
requires an action. In some cases, you 
initiate actions from the wizard 
instruction box by clicking text. In other 
cases, you use the actual screen element. 
Either way, the wizard tells you what to 
do next.  

More about the Course Design 
Center 
The Course Design Center contains 
wizards for the following WebCT CE 
tools: Homepage, Organizer Page, 
Syllabus, Content Module, Discussions, 
Mail, Calendar, and Chat. 

Wizards can be accessed from the Course 
Design Center, from Add Page or Tool on 
the Control Panel, or from the actual tool 
once it’s added to your course. You can 
use any of the wizards from start to finish, 
or you can save your work in a wizard and 
return to it later.  

 

Now, use a wizard to add a heading to the Homepage to help identify your course. 

To create a Homepage heading 
1. Do one of the following: 

• If you’re already logged in to the tutorial course, go to step 4. 

• If you haven’t logged in to the tutorial course, log in. If you need detailed 
instructions, see Logging In on page 7. The myWebCT screen appears. 

Instruction box
Wand icon
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2. Click the tutorial course that was created for you by your WebCT CE administrator, 
Introduction to Internet Communications. The Course Design Center or 
Homepage appears.  

3. Do one of the following: 

• If the Course Design Center appears: 

a. Click Use Course Design Center later. A warning message appears. 

b. Click OK. The Homepage appears. 

• If the Homepage appears, go to step 4. 

4. From the Homepage, in the Actions frame, click Use Homepage Wizard. The 
Wizard: Homepage instruction box appears. 

5. In the instruction box, under Select an option, click Manage textblocks. Textblocks 
are areas of text and/or graphics that you can add to the main frame of some screens. 

6. Again, under Select an option, click Add upper/lower textblock. 

7. Click . 

8. Read the text in the Wizard: Homepage Instruction box. You’ll add a Text Heading. 

9. Under Text Heading, next to Text, enter: Introduction to Internet 
Communications. 

10. Next to Alignment, select Center. 

11. To make the heading stand out, next to Style, select Bold. 

12. Select a text color. From the Color drop-down list, select Navy. 

13. Choose a font size. From the Size drop-down list, select 6. 

Note: The HTML font sizes used here are relative sizes unlike the specific point 
sizes used by most word-processors. HTML font sizes gets progressively 
larger as you move from size 1 to size 7. 

14. Scroll to the bottom of the screen and click . The Wizard: Homepage 
instruction box appears.  
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15. Click Save and exit wizard.  

 
Click Save and exit wizard 

The Homepage appears and your new heading is displayed. 

You’ve seen how your heading looks in Designer Options view. Now, see how the 
heading appears to your students. 

To preview your Homepage 
 From the Menu Bar, click the View tab. The student view of the Homepage appears. 

CHANGING YOUR HOMEPAGE COLORS 
Currently, your Homepage displays the Course Default color set designated by your 
WebCT CE administrator. You can change the color scheme of your Homepage to a 
different pre-defined color set, or your can create your own custom color scheme. 

In this lesson, you’ll create a custom color set by customizing the following on the 
Homepage: 

• text color 

• link color 

• background color 

To create a custom color scheme 
1. From the Homepage, click the Designer Options tab if it isn’t already selected. 

2. In the Actions frame, scroll down to the Customize section and click Customize page 
colors. The Customize Page Colors screen appears. In the table, page colors that are 
currently assigned to each Color Set are displayed under Color Preview. 
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Background 
color 

Custom color 
set section 

3. From the table, under Color Set, select Custom. Currently, the Text color is black; 
keep that color. 

4. Under Custom, click Set link color.  

5. From the color grid, select any shade of blue that you like. The color is shown in the 
Preview frame.  

6. Click Update. The Customize Page Colors screen appears and the Link color is 
updated.  

7. Under Custom, click Set background color. 

8. From the color grid, select any shade of pale yellow that you like. The color is shown 
in the Preview frame. 

9. Click Update. The Customize Page Colors screen appears and the Custom 
background color is updated. 

10. Verify that the Custom color set is still selected. 

11. Click Update. The Homepage appears displaying the new color scheme. You won’t 
be able to see the new link color until you add some tools to the Homepage. You’ll 
add more tools in the next few lessons. Remember to look for the link color at that 
time. 

Now, see how the new color set appears to your students. 

To preview your Homepage 
 From the Menu Bar, click the View tab. The student view of the Homepage appears. 
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You’re finished the activities in this lesson. Go to the next section, Related Activities, or 
the next lesson. 

RELATED AC TIV IT IES 
If you’re interested in customizing your Homepage further, you may want to spend some 
time working through some of the following activities.  

Note: To access the Help Index, click Help on the Menu Bar and then near the top of the 
screen, click Help Index. 

 
To… Go to… 

• add lower textblocks 
• edit, delete, or organize textblocks 

• the online Help topic: Homepage - 
Modifying Textblocks.  

• add images to the Homepage 
• change the background color  
• add a banner to the top of the page 

• the online Help topic: Homepage - 
Modifying Format.  

• use the Homepage wizard to: manage 
textblocks, select background and banner 
images, modify layout,  or customize page 
colors 

• the Homepage Wizard in the Actions 
frame. More information about the 
wizards can be found in the online Help 
topic: Course Design Center. 

  

You’re finished Lesson 3: Customizing your Homepage. In the next lesson, you’ll learn 
how to add your course syllabus to a WebCT CE course. 
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LESSON 4: ADDING A SYLLABUS 

A syllabus is a course’s instructional road map designed to assist both the instructor and 
the student. It’s a summary outline of the course’s planned lessons, activities, resources, 
and student requirements. With WebCT CE’s Syllabus, you can upload a course syllabus 
that’s already prepared, or create a customized syllabus using the Syllabus tool.  

LEAR NING OBJECTIVES 
After completing this lesson, you’ll be able to: 

• create a link to Syllabus on your Course Menu and Homepage. 

• upload a zip file of course content and unzip it. 

• add a course syllabus to your course. 

• modify a syllabus by adding or removing content. 

• use the HTML editor to edit files. 

• refer to the online Help to get more information about other Syllabus options. 

SYLLABUS ACTIV IT IES 
There are four activities in this lesson: 

• adding Syllabus to your course  

• uploading the sample tutorial files 

• adding a course syllabus 

• editing a syllabus 

ADDING SYLLABUS 
First, add Syllabus to your course.  

1. Do one of the following: 

• If you’re already logged in to the tutorial course, go to step 4. 

• If you haven’t logged in to the tutorial course, log in. If you need detailed 
instructions, see Logging In on page 7. The myWebCT screen appears. 

2. Click Introduction to Internet Communications. This is the tutorial course that was 
created by your WebCT CE administrator. The Course Design Center or the 
Homepage appears. 
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3. Do one of the following: 

• If the Course Design Center appears: 

a. Click Use Course Design Center later. A warning message appears. 

b. Click OK. The Homepage appears. 

• If the Homepage appears, go to step 4. 

4. From your Homepage, under Options: Links, click Add Page or Tool. The Add Page 
or Tool screen appears.  

Tip: You can also access Add Page or Tool from the Control Panel. 

5. If the Use a wizard when available check box is selected, clear it. You won’t use a 
wizard to add the Syllabus tool for this lesson. 

6. Under Course Content Tools, click Syllabus. The Add Syllabus screen appears. 

7. In the Enter a title for this item text box, enter: Syllabus 

8. Select where to add links to Syllabus: 

a. Select On the Course Menu. 

b. Select On an Organizer Page: Homepage. 

Notice that Link shows item title, Link shows icon, and Use default icons are selected 
by default. Leave these items selected so that the link on the Homepage displays the 
title and a default icon. 

9. Click Add. The Homepage appears. Notice that there are now links to Syllabus on 
both the Homepage and the Course Menu. 

If you’ve already completed Lesson 3: Customizing your Homepage, look for the link 
color you selected. 

Next, add the sample tutorial files to your course so they can be used in upcoming 
activities.  

ADDING THE SAMPLE TUTORIAL FILES TO YOUR COURSE 
Note: If you’ve already added the sample tutorial files to your course, go to Adding a 

Course Syllabus on page 31. 

Four sample course content files for use with this tutorial are contained in a zip 
(compressed) file that you can download from the WebCT website. To add these files to 
your course, you need to do the following three tasks: 

1. Download the zip file to your computer. Details appear below. 

2. Upload the zip file from your computer to the WebCT server. Details appear 
below. 

3. Unzip the zip file to add the sample tutorial files to the file storage area. Details 
appear below. 
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To download the sample tutorial files 
1. From within your WebCT course, make the necessary selections from your web 

browser’s toolbar to open a second browser window. 

2. In the second browser window, navigate to http://www.webct.com/customer 

3. From the web page that is displayed, click WebCT Documentation. 

4. Under Getting Started Tutorial, click WebCT Campus Edition 4.0 Tutorial Files. A 
dialog box appears asking if you want to save or open the file. 

5. Save the file to your local hard drive. 

6. Once the download is complete, close the dialog box and the second browser 
window. 

Note: Don’t unzip the file. 

7. Go to the next procedure. 

To upload the sample tutorial files 
Course content files are uploaded to the WebCT server using Manage Files. Manage 
Files is the central file storage area and file management utility for your WebCT CE 
course. You can access Manage Files from the Control Panel. 

The files in Manage Files are organized into two folders: 

• My-Files - Your course folder in which you can store, create, and edit files for 
your course. All uploaded files are stored here. 

• WebCT-Files - A folder that contains the default files that are packaged with 
WebCT CE. 

More about file formats 
Course content files that use Text (.txt) and HTML 
(.html, .htm) file formats are recommended. These 
formats can be edited in WebCT CE and all users 
can view them within their web browsers. File 
formats, such as .doc (Word document) and .xls 
(Excel spreadsheet) among others, can also be used 
in your online course. However, users must have the 
corresponding software, such as Microsoft Word or 
Excel, installed on their computers to view these 
files. 

In this activity, you’ll use Manage 
Files to upload the zip file from your 
computer to the WebCT server. The 
four files contained in the zip file are 
all HTML files. HTML is a file format 
that can be read by any web browser. 

Now, upload the zip file to the 
WebCT server. 

 

1. Click Control Panel. The Basic Control Panel appears. 

2. From the Control Panel, click Manage Files. The Folders and Files screen appears.  

3. In the Actions frame, under Options: Files, click Upload. The Upload File screen 
appears 

4. Next to the Filename text box, click Browse. Your computer’s file browser appears.  
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5. Select the zip file you downloaded from the WebCT website and open it. The Upload 
File screen appears and the zip file appears in the Filename text box. 

 Click Upload

6. Click Upload. The zip file is added to the Folders and Files list in the My-Files 
folder. 

 

7. Go to the next procedure. 

Unzipping the sample tutorial files 
Manage Files contains built-in Zip and Unzip options. Now, unzip the zip file to add the 
four sample tutorial files to the My-Files folder. 

1. From the Folders and Files list, select the zip file. 
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2. In the Actions frame, under Options: Files, click Unzip. 

 

Zip file is 
selected 

Click Unzip

The Unzip File screen appears. 

3. Click Unzip. The Folders and Files screen appears and the following four files are 
added to the My-Files folder:  

• tutorial_discussion.html 

• tutorial_email.html 

• tutorial_introduction .html 

• tutorial_syllabus.html 

4. The contents of the zip file are extracted. You can delete the zip file. From the 
Folders and Files list, select the zip file. 

 
Zip file is selected 
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5. In the Actions frame, under Options: Files, click Delete. The Delete Files screen 
appears. 

6. Under Confirm Delete Files, click Delete. The Folders and Files screen appears and 
the zip file is deleted. 

The remaining files are added to the file storage area in Manage Files. To make these 
course content files accessible to your students, you have to add them to one of the course 
content areas of your course, such as Syllabus. 

Next, add the tutorial_syllabus.html file to Syllabus.  

Note: The remaining three files are added to Content Module in Lesson 5: Adding 
Course Content. 

ADDING A COURSE SYLLABUS 
1. From the Course Menu, click Syllabus. The Syllabus screen appears. 

2. In the Actions frame, under Syllabus Source, select Syllabus file. The Syllabus screen 
updates to display the Syllabus file screen: 

 

3. Under Syllabus, next to the Filename text box, click Browse. The File Browser 
appears. The File Browser allows you to select files contained in Manage Files or 
upload files from your computer.  

Note: In the previous activity, you didn’t use the File Browser to upload the zip file 
because the Unzip option isn’t accessible from the File Browser. 

4. Under My-Files, select the tutorial_syllabus.html file. 

Tip: To preview the file, click . 

5. At the bottom of the screen, click Add selected. The Syllabus screen appears, and 
the filename of the uploaded file is displayed in the Filename text box. 
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6. Click Update. The filename appears next to Current file. 

 

Uploaded file is now the current 
file being used in Syllabus 

See how the file is displayed to your students. 

To preview your syllabus 
 To preview the syllabus, click the View tab. 

Next, edit the file you just uploaded and add some new content. 

EDITING A SYLLABUS FILE 
You can edit any file within WebCT CE if the file format is .txt, .htm, or .html. 
Other file formats must be edited on your computer using the appropriate software and 
then uploaded again to your course. For example, if you want to edit a syllabus created in 
Microsoft Word, edit it first on your computer using MS Word and then upload it to the 
WebCT server using either Manage Files or the File Browser in Syllabus. The edited file 
automatically replaces the original syllabus file. 

In this lesson, you’ll use Manage Files to edit the tutorial_syllabus.html file. 

To edit the file 
1. Click Control Panel. The Basic Control Panel appears. 

2. Click Manage Files. The Folders and Files screen appears displaying the two 
folders, My-Files and WebCT-Files, and the files you uploaded.  
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3. Under My-Files, select the tutorial_syllabus.html file. 

 

Selected file 

4. Under Options: Files, click Edit. The Edit File screen appears and the file is 
displayed in the File content box. Note the HTML tags incorporated into the text. 

5. Click HTML editor. The Edit File screen updates and a word-processor-like editor 
appears. This tool allows you to edit text and apply formatting to your HTML 
document without entering any HTML tags.  

Note: For additional information on using the HTML editor, click ? on the toolbar. 

6. Using the HTML editor’s scroll bar, scroll down to Lesson 2 under Course Outline 
and Reading Assignments.  

7. Add the following reading assignment: Read Chapter 1 of Technical 
Communication and the Internet. 

8. Select the text, Technical Communication and the Internet.  

9. Indicate that this is the name of a publication, by applying the italics font style. From 
the HTML editor’s toolbar, select .  
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Selected text 

 

The text is now in italics. 

10. Scroll to the bottom of the screen and click Update. The Folders and Files screen 
appears and the file is updated.  

Next, see how the revised syllabus appears to your students. 

To preview the new Syllabus 
1. From the Course Menu, click Syllabus. The Syllabus screen appears. 

2. To preview the syllabus, click the View tab. 

 

You’re finished the activities in this lesson. Go to the next section, Related Activities, or 
the next lesson. 
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RELATED AC TIV IT IES 
If you’re interesting in exploring Syllabus further, you may want to spend some time 
working through some of the following activities. 

Note: To access the Help Index, click Help on the Menu Bar and then near the top of the 
screen, click Help Index. 

 
To… Go to… 
• create a new syllabus using the Syllabus 

tool, including: 
o adding a section 
o editing a section 
o hiding a section of the syllabus 
o reorganizing the syllabus 

sections 
o deleting all sections in a 

syllabus 
• switch between an uploaded syllabus file 

and a syllabus created using the Syllabus 
tool 

• the online Help topic: Syllabus. 

 

 

You’re finished Lesson 4: Adding a Syllabus. In the next lesson, you’ll learn how to use 
WebCT CE to make course materials available to your students.  
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LESSON 5: ADDING COURSE 
CONTENT 

A Content Module is an area where you can place course material such as lecture notes or 
reading material. If desired, you can create multiple content modules to organize your 
course material according to the structure of your course. For example, you could create a 
separate content module for each course unit or section.  

The online course objectives that you set out in the course-planning phase will help to 
determine how you’ll use Content Module in your course. If you’re creating a truly web-
based course, material that would be presented in the classroom in a traditional course 
would be offered online through the content modules. In this case, the content modules 
would probably make up the bulk of your WebCT CE course. However, if you’re using 
WebCT CE to supplement a classroom course, the content modules may play a less 
significant role.  

LEAR NING OBJECTIVES 
After completing this lesson, you’ll be able to: 

• create a link to Content Module on your Course Menu and Homepage. 

• modify Homepage links. 

• upload a zip file of course content and unzip it. 

• add course content files to a content module. 

• create a table of contents that organizes the course content in a meaningful way. 

• add tools to content pages that students can use to enrich their learning 
experience. 

• explain the importance of Update Student view. 

• refer to the online Help section to get more information about other Content 
Module options. 

CONTENT MODULE ACTIV IT IES 
There are seven activities in this lesson: 

• adding Content Module to your course 

• changing a link’s appearance on the Homepage 

• uploading the sample tutorial files 
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• adding content to the Content Module 

• organizing the Content Module 

• allowing students to make study notes in the content pages 

• making the Content Module available to students 

ADDING A CONTENT MODULE 
First, add Content Module to your course.  

1. Do one of the following: 

• If you’re already logged in to the tutorial course, go to step 4. 

• If you haven’t logged in to the tutorial course, log in. If you need detailed 
instructions, see Logging In on page 7. The myWebCT screen appears. 

2. Click Introduction to Internet Communications. This is the tutorial course that was 
created by your WebCT CE administrator. The Course Design Center or the 
Homepage appears. 

3. Do one of the following: 

• If the Course Design Center appears: 

a. Click Use Course Design Center later. A warning message appears. 

b. Click OK. The Homepage appears. 

• If the Homepage appears, go to step 4. 

4. Click Control Panel. The Basic Control Panel screen appears. 

5. Click Add Page or Tool. The Add Page or Tool screen appears. 

6. If the Use a wizard when available check box is selected, clear it. You won’t use a 
wizard to add the Content Module tool for this lesson. 

7. Under Course Content Tools, click Content Module. The Add Content Module 
screen appears. 

8. In the Enter a title for this item text box, enter: Course Material 

9. Select where to add links to Course Material: 

a. Select On the Course Menu. 

b. Select On an Organizer Page: Homepage. 

Notice that Link shows item title, Link shows icon, and Use default icon are selected 
by default. Leave these items selected so that the link on the Homepage displays the 
title and a default icon. 

10. Click Add. The Homepage appears. Notice that there are now links to Course 
Material on both the Homepage and the Course Menu.  
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CHANGING LINK CHARACTERISTICS 
If you’ve already completed Lesson 4: Syllabus, you now have two links on your 
Homepage: Syllabus and Course Material. You can modify the appearance of the 
Homepage links at any time using options in the Actions frame. 

In this lesson, you’ve decided that you want to edit (change) the icon for Course 
Material.  

Note: This is an optional activity and is presented here for instructional purposes. You 
don’t have to change the icon of the Content Module tool before you add content 
to it.  

1. From the Homepage, in the Actions frame, under Options: Links, notice the  image 
next to Edit. This image indicates that you must select an item from the main frame 
before you choose this option.  

2. Select the radio button next to the Course Material link. 

 

radio 
button 

Click Edit

3. In the Actions frame, under Options: Links, click Edit. The Update Link to Content 
Module screen appears. 

4. Under Basic Settings, next to the Icon filename text box, click Browse. The File 
Browser appears.  

The WebCT-Files folder contains subfolders that hold various background, banner, and 
icon images that you can use in your course. You want to find a new icon image. 

5. Click WebCT- Files to open the folder. A list of subfolders appears. 

6. Click icons. Another set of subfolders appears. 

7. Scroll down and click webct_photo. A list of images appears. 

8. Scroll down and select contents.jpg.  

Tip: To preview the image, click . 

9. At the bottom of the File Browser screen, click Add selected. The Update Link to 
Content Module screen appears. 

10. At the bottom of the screen, click Update. The Homepage appears and the new icon 
is displayed. 

Next, add some content to the module for your students to view. 
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ADDING THE SAMPLE TUTORIAL FILES TO YOUR COURSE 
Note: If you’ve already added the sample tutorial files to your course, go to Adding 

Content to the Content Module on page 42. 

Four sample course content files for use with this tutorial are contained in a zip 
(compressed) file that can be downloaded from the WebCT website. To add these files to 
your course, you need to do the following three tasks: 

1. Download the zip file to your computer. Details appear below. 

2. Upload the zip file from your computer to the WebCT server. Details appear below. 

3. Unzip the zip file to add the sample tutorial files to the file storage area. Details 
appear below. 

To download the sample tutorial files 
1. From within your WebCT course, make the necessary selections from your web 

browser’s toolbar to open a second browser window. 

2. In the second browser window, navigate to http://www.webct.com/customer 

3. From the web page displayed, click WebCT Documentation. 

4. Under Getting Started, click WebCT Campus Edition 4.0 Tutorial Files. A dialog 
box appears asking if you want to save or open the file. 

5. Save the file to your local hard drive. 

6. Once the download is complete, close the dialog box and the second browser 
window. 

Note: Don’t unzip the file. 

7. Go to the next procedure. 

To upload the sample tutorial files 
Course content files are uploaded to the WebCT server using Manage Files. Manage 
Files, which is accessed from the Control Panel, is the central file storage area and file 
management utility for your WebCT CE course. 

The files in Manage Files are organized into two folders: 

• My-Files - Your course folder in which you can store, create, and edit files for 
your course. All uploaded files are stored here. 

• WebCT-Files - A folder that contains the default files that are packaged with 
WebCT CE. 
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In this activity, you’ll use Manage 
Files to upload the zip file from your 
computer to the WebCT server. The 
four files contained in the zip file are 
all HTML files. HTML is a file 
format that can be read by any web 
browser. 

More about file formats 
Course content files that use Text (.txt) and HTML 
(.html, .htm) file formats are recommended. These 
formats can be edited in WebCT CE and all users 
can view them within their web browsers. File 
formats, such as .doc (Word document) and .xls 
(Excel spreadsheet) among others, can also be used 
in your online course. However, users must have the 
corresponding software, such as Microsoft Word or 
Excel, installed on their computers to view these 
files. 

Now, upload the zip file to the 
WebCT server. 

1. From the Control Panel, click Manage Files. The Folders and Files screen appears.  

2. In the Actions frame, under Options: Files, click Upload. The Upload File screen 
appears 

3. Next to the Filename text box, click Browse. Your computer’s file browser appears.  

4. Select the zip file you downloaded from the WebCT website and open it. The Upload 
File screen appears and the zip file appears in the Filename text box. 

  Click Upload

5. Click Upload. The zip file is added to the Folders and Files list in the My-Files 
folder. 

 

6. Go to the next procedure. 
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Unzipping the sample tutorial files 
Manage Files contains built-in Zip and Unzip options. Now, unzip the zip file to add the 
four sample tutorial files to the My-Files folder. 

1. From the Folders and Files list, select the zip file. 

2. In the Actions frame, under Options: Files, click Unzip.  

 

Zip file is 
selected 

Click Unzip

The Unzip File screen appears. 

3. Click Unzip. The Folders and Files screen appears and the following four files are 
added to the My-Files folder:  

• tutorial_discussion.html 

• tutorial_email.html 

• tutorial_introduction .html 

• tutorial_syllabus.html 
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4. The contents of the zip file are extracted. You can delete the zip file. From the 
Folders and Files list, select the zip file. 

 
Selected zip file 

5. In the Actions frame, under Options: Files, click Delete. The Delete Files screen 
appears. 

6. Under Confirm Delete Files, click Delete. The Folders and Files screen appears and 
the file is deleted. 

The files are added to the file storage are, Manage Files. To make these course content 
files accessible to your students, you have to add them to one of the course content areas 
of your course, such as Content Module. 

Next, add tutorial_discussion.html, tutorial_email.html, and 
tutorial_introduction.html to the Course Material content module.  

Note: The remaining file, tutorial_syllabus.html, is added to Syllabus in 
Lesson 4: Adding a Syllabus. 

ADDING CONTENT TO THE CONTENT MODULE 
In this activity, you’ll add three uploaded course content files to your content module.  

Tip: You can also create new content pages for your WebCT CE course using the 
Create file option in Manage Files. For more information, see the online Help 
topic, Manage Files – File Options. To access the online Help, click Help on the 
Menu Bar. 

1. From the Homepage or Course Menu, click Course Material. The Table of Contents 
screen appears.  

2. Under Options: Table of Contents, click Add files. The Add Files screen appears. 
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3. Select tutorial_discussion.html, tutorial_email.html, and 
tutorial_introduction.html by holding the CTRL key on your keyboard 
while you select each file from the Filenames text box. 

4. At the bottom of the screen, click Add. The Table of Contents screen appears and the 
files are added to the Table of Contents.  

5. To change the titles of the documents, under Options: Table of Contents, click Edit 
titles. The Edit Content Page Titles screen appears. 

6. Rename the documents as listed below: 

 
Filename Title 
tutorial_discussion.html About Discussion groups 
tutorial_email.html About Email 
tutorial_introduction.html Introduction to Internet Communications 

 

7. Click Update. The Table of Contents screen appears and the files are renamed.  

Your Table of Contents screen should look like this: 

 

ORGANIZING THE CONTENT MODULE 
As you saw in the last activity, each file you add to a content module creates a link in the 
Table of Contents. By default, the Table of Contents screen is the first screen your 
students see when they enter a content module. You can organize the links within the 
Table of Contents to suggest the sequence in which the material should be studied. This 
allows students to see — at a glance — what the material covers and the order in which it 
should be viewed. Students view a page of content by clicking its link in the Table of 
Contents.  

43 



A Table of Contents might look like this: 

 

Now, reorganize your content files in the Table of Contents, add headings, and indent the 
files under each heading.  

To move an item 
First move the introduction.html file to the top of the Table of Contents. 

1. From the Table of Contents screen, select the file titled: Introduction to 
Internet Communications. 

2. In the Actions frame, under Organize, in the Move item up by drop-down list, select 2 
and click Go. The Table of Contents screen updates and the file is moved to the top. 

Next, add some headings to the Table of Contents.  

To create headings 
1. From the Table of Contents screen, select the file titled: Introduction to 

Internet Communications. The new heading is added below this file. 

2. Under Options: Table of Contents, click Add heading. The Add Heading screen 
appears. 

3. In the Title text box, enter: Discussions Groups 

4. Click Add. The Table of Contents screen appears and the heading is added. 

5. Repeat steps 1 through 4 to create a heading under the About Discussion 
Groups file. For the heading title, enter: Email 
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Your Table of Contents screen should look like this: 

 

Next, indent the files under the headings. 

To place a file within a heading 
1. From the Table of Contents, select the file titled About Discussion groups 

2. Under Organize, from the Indent item drop-down list, select More and click Go. The 
file is indented under the heading Discussion groups 

3. Repeat steps 1 and 2 to indent the Email file under the Email heading. 

Your Table of Contents screen should look like this: 

 

Tip: You can collapse the heading by clicking on the green arrow ( ). To expand 
it, click . 

You’ve added three files to your content module, Course Material, and have organized 
them in the Table of Contents. Now, see how the content module appears to your 
students. 

To preview the Content Module 
1. To preview the content module, click the View tab. 
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2. From the Table of Contents, click Introduction to Internet Communications. The 
content page appears displaying the file that you uploaded.  

Notice the toolbar across the top of the page. This is the Action Menu. There are five 
navigational buttons that appear on the menu by default as described below. 

 Retrace your path 

 
 

3. View the other two files that you added to Course Material by clicking  on the 
Action Menu. 

4. Return to the Table of Contents screen by clicking  on the Action Menu. 

You can also add items to the Action Menu that assist students in their studies. In the next 
activity, you’ll add an item to allow students to take study notes. 

ALLOWING STUDENTS TO ANNOTATE THEIR CONTENT PAGES 
Within Content Module, you can provide additional tools to assist students with their 
studies. You can add a link to a course Index or a Glossary. You can also add a link to 
other WebCT CE course elements such as Chat and Mail. These tools are available to 
students through the Action Menu that appears at the top of each content page. 

A content page’s Action Menu might look like this: 

 

Previous page 
Go to Table of Contents  Refresh this page

from the serverNext page 

In this activity, you’ll add Take Notes to the Action Menu of all content pages. This 
feature allows students to attach study notes to content pages.  

Note: You can also add tools, such as Audio or Video, to individual content pages. For 
more information on adding tools to individual content pages, see the online Help 
topic, About Content Pages. To access Help, click Help on the Menu Bar. 

To add Take Notes 
1. Click the Designer Options tab. The designer view of the Table of Contents screen 

appears. 

2. From the Table of Contents screen, under Options: Content Module, click Edit 
Content Module settings. The Content Module Settings screen appears. 

3. Under Action Menu, in the lower section, select Take Notes.  

4. Scroll to the bottom of the screen and click Update. The Table of Contents screen 
appears. 

Now, see the updated Action Menu. 
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To preview the new Action Menu link 
1. Click the View tab. The student view of the Table of Contents screen appears. 

2. Click any of the content pages. The content page appears displaying the Action Menu. 

 

3. Click Take Notes. A new browser window appears where students can enter study 
notes. 

4. Close the browser window. 

5. In the breadcrumbs, click Course Material. The student view of the Table of 
Contents screen appears.  

6. Return to designer view by clicking the Designer Options tab. 

MAKING THE CONTENT MODULE AVAILABLE TO STUDENTS 
It’s important to realize that although the new content module you’ve created is displayed 
in View, it’s not yet visible to your students. Each time you make any changes to a 
content module, you must update the student view.  

1. From the Table of Contents screen, under Options: Content Module, click Update 
student view. The Update Student View of Content Pages screen appears. 

2. Select Update entire course and then click Update. The Update Student View Report 
screen appears confirming that the pages are updated. 

3. To return to the Table of Contents screen, in the breadcrumbs, click Course Material. 
The students can now see the new content pages and updated Action Menu. 

Tip: You can also access Update Student View in the Basic Control Panel under Edit 
Page or Tool. 

 

You’re finished with the activities in this lesson. Go to the next section, Related 
Activities, or the next lesson. 

RELATED AC TIV IT IES 
If you’re interesting in exploring more Content Module features, you may want to spend 
some time working through some of the following activities. 

Note: To access the Help Index, click Help on the Menu Bar and then near the top of the 
screen, click Help Index. 
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To… Go to… 

• change the appearance of the content 
pages 

• the online Help topic: Customizing 
Content Module Appearance. 

• create a content page in WebCT CE  • the online Help topic, Manage Files - File 
Options. 

• edit a content page in WebCT CE • the online Help topic: Adding Course 
Content. 

• change the appearance of the Table of  
Contents screen 

• reorganize the Table of Contents 

• the online Help topic, About Content 
Module. 

• edit and delete Table of Contents entries • the online Help topic, Deleting Course 
Content. 

• add one of the following to the Action 
Menu: 

o Audio or Video clips 
o Links 
o Glossary 
o Index 
o Goals 
o Quiz 
o References 
o Self test 
o Chat 
o Discussions 
o Mail 

• delete items from the Action Menu 

• the online Help topic: Index for Content 
Module and then see Action Menu or one 
of the tool specific topics. 

 
 
 
 
 
 
 
 
 
 
 

• change the appearance of the Action Menu • the online Help topic: Editing the Table of 
Contents and Action Menu 

You’re finished Lesson 5: Adding Course Content. In the next lesson you’ll create a 
discussions area and a chat area to allow users in your course to communicate with each 
other. 
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PART THREE: ADDING 
COMMUNICATION AND 
EVALUATION TOOLS 
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LESSON 6: COMMUNICATING WITH 
YOUR STUDENTS 

You can use WebCT CE to add online communication to your course. The main WebCT 
CE communication tools are Discussions, Mail, Chat, and Whiteboard. 

Discussions is a forum where messages can be posted and replied to within predefined 
topic areas. Message content is generally limited to issues that relate directly to the topic 
area. Mail, which uses terminology and functionality that is similar to Discussions, is 
used when confidentiality is important, when the issue is specific to the message 
recipient, or when the issue is outside of any of the topic areas. Both Discussions and 
Mail allow students, instructors, and teaching assistants to engage in course 
communications at any time. Messages can be posted and replied to at the user’s 
convenience. 

Chat and Whiteboard allow logged in users to exchange information in real time. Chat 
and Whiteboard sessions can be pre-scheduled, or users can communicate with 
whomever happens to be logged in at the time. Chat is restricted to text-only 
communication while Whiteboard allows users to enhance their messages with images 
and graphics. 

In the first section of this lesson, you’ll learn about creating a Discussions area in your 
course. Once you’ve completed this section, you can apply what you’ve learned to Mail. 
In general, you post, view, and reply to messages in both Discussions and Mail in the 
same way. 

In the second section, you’ll learn about creating a Chat area.  

Whiteboard, which is not covered in this lesson, is similar to Chat but has some unique 
features. For detailed instructions on its use, see Whiteboard in the online Help. To 
access Help, click Help on the Menu Bar. 

CREATING A  DISC USSIONS AR EA 
Before you and your students can use Discussions, you need to add the Discussions tool 
to your course and then create a topic area for discussion. Users can reply to messages 
already posted, or they can introduce new issues related to the topic area. Students can’t 
create topic areas. 

LEAR NING OBJECTIVES 
After completing this lesson, you’ll be able to: 

• create a link to Discussions on your Course Menu and Homepage. 
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• create topics to engage students in focused discussions. 

• send messages. 

• view and reply to messages. 

• refer to the online Help to get more information about other Discussions options. 

DISCU SSION S ACT IV IT IES 
There are five activities in the Discussions portion of this lesson: 

• adding Discussions to your course 

• creating a topic for discussion 

• sending a message 

• replying to a message 

• viewing messages 

ADDING DISCUSSIONS 
First, add Discussions to your course.  

1. Do one of the following: 

• If you’re already logged in to the tutorial course, go to step 4. 

• If you haven’t logged in to the tutorial course, log in. If you need detailed 
instructions, see Logging In on page 7. The myWebCT screen appears. 

2. Click Introduction to Internet Communications. This is the tutorial course that was 
created by your WebCT CE administrator. The Course Design Center or the 
Homepage appears. 

3. Do one of the following: 

• If the Course Design Center appears: 

a. Click Use Course Design Center later. A warning message appears. 

b. Click OK. The Homepage appears. 

• If the Homepage appears, go to step 4. 

4. Click Control Panel. The Basic Control Panel appears.  

5. Click Add Page or Tool. The Add Page or Tool screen appears. 

6. If the Use a wizard when available check box is selected, clear it. You won’t use a 
wizard to add the Discussions tool for this lesson. 

7. Under Communication Tools, click Discussions. The Add Discussions screen 
appears. 
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8. In the Enter a title for this item text box, enter: Discussions 

9. Select where to add links to Discussions: 

a. Select On the Course Menu. 

b. Select On an Organizer Page: Homepage. 

Notice that Link shows item title, Link shows icon, and Use default icon are selected 
by default. Leave these items selected so that the link on the Homepage displays the 
title and a default icon. 

10. Click Add. The Homepage appears. Notice that there are now links to Discussions on 
both the Homepage and the Course Menu.  

Next, go to Discussions and create a new topic. 

CREATING A DISCUSSION TOPIC 
The Discussions area is divided into topics. This allows you to create information 
exchange forums around particular subjects. Topics can be public or private. Everyone in 
your course can access public topics, while private topics are only accessible to selected 
students, instructors, and teaching assistants. 

 From the Course Menu or Homepage, click Discussions. The Discussions screen 
appears.  

 

Topic table Status columns

The Topic table contains three default topics: All, Main, and Notes. All contains all 
messages from all public topics, Main is the principal discussion area, and Notes contains 
all messages related to specific pages of content in a content module. 

Since the course is new, there are no messages in any of the topics. Note the empty check 
boxes under Private, Anonymous, and Locked. These are the Status columns. This means 
that all members can post to the topics but not anonymously.  
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Note: For detailed information about the Status columns, see the online Help topic, 
Discussions - Managing Topics. To access Help, click Help on the Menu Bar. 

Next, create a discussion topic on netiquette, which is a term often used to describe 
Internet etiquette. 

To create a topic 
1. In the Actions frame, under Options, click Create topic. The Create Topic screen 

appears. 

2. In the Topic name text box, enter: Netiquette 

3. Click Create. The Discussions screen appears and Netiquette is added to the Topic 
table. 

Next, create and post a message under the Netiquette topic. 

CREATING A MESSAGE 
All Public messages posted in Discussions appear to all users in the course. In this 
tutorial, there are no other users, so you’re the only one who can see new messages. As 
users respond to a message, a message thread is formed. Each thread begins with a 
Subject heading followed by the original message, and then the thread of replies. This 
concept will become clearer as you complete the Discussions activities. 

1. In the table, under Topic, click Netiquette. The Discussion Messages: Netiquette 
screen appears. 

2. Click Compose message. The Compose Discussion Message window appears.  

3. In the Subject text box, enter: Flame 

4. In the Message text box, enter: Does anyone know what this word 
means? 

5. Click Post. The Discussion Messages: Netiquette screen appears.  

6. To see the message, click Update listing. While you are working in Discussions, new 
messages are not displayed until the listing is updated. 
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7. A Subject heading, Flame, is created for the message that you posted. All replies to 
your message will be listed under this Subject heading in a thread. 

  

 

4. To see your message, click  under Status. 

REPLYING TO A MESSAGE 
Now, try replying to the message that you sent. Normally, someone else would reply to 
your message, but since there are no students in this tutorial course, this is the best way to 
show you how messages are displayed. 

1. Next to , click Flame. Your message appears. It includes your name, along with the 
date and time that the message was sent. 

2. Click Reply. The Reply to Message window appears. 

3. In the Message text box, enter: To “flame” means to express a strong 
or critical opinion. It can also mean to be insulting or 
inflammatory. 

4. Click Post. The Discussion Messages: Netiquette screen appears. 

5. Click Update listing. If you don’t see your messages, next to Display, click All. 

VIEWING MESSAGES 
Your Discussion Messages screen should look something like this: 

 

Message read 

View all messages 
in a thread

Message unread 
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This screen provides various ways to view your messages. Spend some time now 
exploring the Display options: All, Unread, Threaded, and Unthreaded. Also, view the 
message thread using the magnifying glass icon . This is the best way to view all the 
messages of a thread at once. Refer to the Tips below for assistance.  

Tips: 
• To display all messages, both read and unread, click All. 
• To display only new messages and messages that you haven’t read yet, click Unread. 

• To display your messages by subject, click Threaded. When messages are displayed by 
thread, you’ll see the subject of the thread, and then the original message on that subject.  
Replies are indented under the original message. 

• To display your messages in chronological order, click Unthreaded. 

• To view messages in another topic, from the Select topic drop-down list, select a topic 
and click Go. 

 In the breadcrumbs, click Homepage to return to your home base. 

 

You’re finished the Discussions activities. Go to the next section, Related Activities, or the 
next lesson topic, Chat. 

RELATED AC TIV IT IES 
If you’re interested in learning more about using Discussions, you may want to spend 
some time working through some of the following activities. 

Note: To access the Help Index, click Help on the Menu Bar and then near the top of the 
screen, click Help Index. 

To… Go to… 

• rename topics 
• delete topics 
• create private topics 
• lock topics 
• allow anonymous postings to topics 
• organize topics 

• the online Help topic: Discussions – 
Managing Topics.  

• mark messages as read or unread 
• search messages 
• compile messages 
• download messages 

• the online Help topic: Discussions – 
Reading and Sending Messages. 

 

• move messages to a different topic 
• delete messages 

• the online Help topic: Discussions–  
Managing Messages 
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CREATING A  CHAT AREA 
In a traditional classroom environment, students have opportunities to discuss course 
content, ask questions, and interact with each other. Chat allows you and your students to 
engage in similar activities online and in real time. It can be useful when students need to 
collaborate on group projects. Or, you can use Chat to hold weekly “office hours” when 
students can ask questions, and you can address their concerns. 

LEAR NING OBJECTIVES 
After completing this lesson, you’ll be able to: 

• adjust your browser settings to allow Chat to work correctly. 

• create a link to Chat on your Course Menu and Homepage. 

• customize the appearance of the Chat screen. 

• use Chat to communicate synchronously with your students. 

• view the chat room logs. 

• refer to the online Help to get more information about other Chat options. 

CHAT ACTIV IT IES 
There are five activities in this lesson: 

• checking your browser settings  

• adding Chat to your course 

• customizing the Chat screen 

• participating in a Chat session 

• viewing a Chat room log 

CHECKING YOUR BROWSER SETTINGS 
Before you start using Chat, you must enable Java® in your browser. Refer to the set of 
instructions below that apply to the browser you are using to view your course. 

To enable Java in Netscape Navigator  
WebCT CE supports the following versions of Navigator: 6.2.1, 6.2.2, 6.2.3, 7.0, and 
7.0.1. 

1. Open Netscape Navigator. 
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2. From the Edit menu, click Preferences. 

3. In the Category section, click Advanced. 

4. Ensure that Enable Java is selected. 

5. Click OK. The browser window appears and Java is enabled. 

Now that your browser is optimized for Chat, go on to the next activity. 

To enable Java in Microsoft Internet Explorer  
WebCT CE supports the following versions of Internet Explorer: 5.x and higher  

Note:  IE 5.5 SP1 is not supported. 

1. Open Microsoft Internet Explorer. 

2. From the Tools menu, click Internet Options. 

3. Click the Security tab. 

4. Click Custom Level. The Security Settings window appears. 

5. Scroll down to Microsoft VM, and under Java permissions, select one of the 
following safety settings:  

• High safety 

• Low safety  

• Medium safety 

6. Click OK. A confirmation message appears.  

7. Click Yes. The Internet Options window appears. 

8. Click OK. The browser window appears and Java is enabled. 

Now that your browser is optimized for Chat, go on to the next activity. 

ADDING CHAT 
First, add Chat to your course. 

1. Click Control Panel. The Basic Control Panel appears. 

2. Click Add Page or Tool. The Add Page or Tool screen appears. 

3. Under Communication Tools, click Chat. The Add Chat screen appears. 

4. In the Enter a title for this item text box, enter: Chat 

5. Select where to add links to Chat: 

a. Select On the Course Menu to display a link here. 

b. Select On an Organizer Page: Homepage to display a link here also. 
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Notice that Link shows item title, Link shows icon, and Use default icon are selected 
by default. Leave these items selected so that the link on the Homepage displays the 
title and a default icon. 

6. Click Add. The Homepage appears. Notice that there are now links to Chat on both 
the Homepage and the Course Menu.  

Next, go to Chat and customize the appearance of the Chat screen. 

CUSTOMIZING THE CHAT SCREEN 
 From the Course Menu or the Homepage, click Chat. The WebCT Chat screen 

appears.  

 

default 
header

Chat 
rooms 

Notice that there’s a default header and six chat rooms. You can’t create more Chat 
rooms, but you can change the names of Rooms 1 through 4. You can also customize the 
appearance of the Chat screen by changing page colors, adding a background image, 
changing the header banner, or adding text.  

Now, change the names of two of the Chat rooms. 

To change Chat room names 
1. In the Actions frame, under Options, click Modify chat room names. The Edit Room 

Names screen appears. 

2. In the Room 1 text box, enter: Virtual Office 

3. In the Room 2 text box, enter: Student Lounge 

4. Click Update. The Chat screen appears displaying the new room names. 

Next, add some text to the lower portion of the screen that will assist Chat users.  

To add a lower textblock 
1. In the Actions frame, under Customize, click Edit/Add lower textblock. The 

Edit/Add Lower Textblock screen appears. 
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2. In the Edit textblock text box, enter: Chat Tip: When you are finished 
typing, enter “=>” to indicate that the floor is open to 
other Chat users. 

3. Click Update. The Chat screen appears displaying the new text. 

PARTICIPATING IN A CHAT SESSION 
 From the list of rooms, click Virtual Office. The Chat window appears. 

 

Posted messages appear here  
Logged 
in Chat 
users 
appear 
here 

Enter your message here 

You’ll notice three main areas: the Output Interaction Box where messages are viewed, a 
message text box where you enter your messages, and the Users Logged on box where 
active Chat users are listed.  

Before you start the Chat session, activate the Entry Chime. 

To activate the Entry Chime 
 Select Entry Chime. The chime notifies you when someone enters the room. Once 

activated, you’ll hear the chime both in Chat and elsewhere in your course. 

Next, send a message to let other Chat users know that your office hours have started. 

To send a message 
In a real course, someone else would receive your message and respond to it. Since this 
isn’t possible in this tutorial, respond to your own message. 

1. Under Enter your message below, enter: My virtual office door is 
open. Any questions? 
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By default, messages are sent to all logged in users. If you don’t want to send the 
message to all users, from the Users logged on box, you select each user to receive the 
message. Since you are currently the only user logged in, the message will only be sent to 
you.  

2. Send the message by pressing Enter on your keyboard. The message appears in the 
Output Interaction Box. 

3. In the Enter your message below text box, respond to the message by entering: I’m 
confused by the diagram on page 36 of the textbook. Can 
you explain, please? 

4.  Send the message by pressing Enter. The message appears in the Output 
Interaction Box. 

 

5. Click Quit. You’re finished participating in the Chat session. The Chat window 
closes and the Chat screen appears. 

Next, view the Chat log for this Chat session. 

VIEWING A CHAT ROOM LOG  
Using the Chat logs, you can view the conversations that occurred in a particular Chat 
session. Students don’t have access to these logs. 

1. From the Actions frame, under Options, from the View room log drop-down list, 
select Virtual Office and click Go. The Chat Log: Virtual Office screen appears. 
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Tip: Once you’ve viewed the logs, you can clear them by clicking Clear log. Over 
time, Chat logs can become quite large and difficult to view. 

2. In the breadcrumbs, click Chat. The Chat screen appears. 

You’re finished the activities in this lesson. Go to the next section, Related Activities, or 
the next lesson. 

RELATED AC TIV IT IES 
If you’re interested in learning more about using Chat, you may want to spend some time 
working through some of the following activities.  

Note: To access the Help Index, click Help on the Menu Bar and then near the top of the 
screen, click Help Index. 

 
To… Go to… 

• add a background image to the Chat screen 
• change Chat’s banner image  
• customize Chat’s page colors 
• change a Chat room name 
• send a private message 

• the online Help topic: Chat. 

  

You’re finished Lesson 6: Communicating with Your Students. In the next lesson, you’ll 
create a course calendar. 
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LESSON 7: CREATING A COURSE 
CALENDAR 

Your course has important dates that you need to communicate to your students. They 
could be assignment due dates, exam dates, scheduled Chat sessions, and other class 
events. You can use WebCT CE’s Calendar to communicate this information to your 
students.  

LEAR NING OBJECTIVES 
After completing this lesson, you’ll be able to: 

• create a link to Calendar on your Course Menu and Homepage. 

• communicate important dates to your students using Calendar. 

• change existing calendar entries. 

• navigate through Calendar using various viewing options. 

• refer to the online Help to get more information about using other Calendar 
options. 

CALENDAR ACTIV IT IES 
There are four activities in this lesson: 

• adding Calendar to your course  

• adding entries to the Calendar 

• editing a Calendar entry  

• viewing the Calendar 

ADDING CALENDAR  
First, add Calendar to your course. 

1. Do one of the following: 

• If you’re already logged in to the tutorial course, go to step 4. 

• If you haven’t logged in to the tutorial course, log in. If you need detailed 
instructions, see Logging In on page 7. The myWebCT screen appears. 
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2. Click Introduction to Internet Communications. This is the tutorial course that was 
created by your WebCT CE administrator. Depending on whether or not you’ve 
logged in before, the Course Design Center or the Homepage appears. 

3. Do one of the following: 

• If the Course Design Center appears: 

a. Click Use Course Design Center later. A warning message appears. 

b. Click OK. The Homepage appears. 

• If the Homepage appears, go to step 4. 

4. Click Control Panel. The Basic Control Panel appears. 

5. Click Add Page or Tool. The Add Page or Tool screen appears. 

6. If the Use a wizard when available check box is selected, clear it. You won’t use a 
wizard to add the Calendar tool for this lesson. 

7. Under Communication Tools, click Calendar. The Add Calendar screen appears. 

8. In the Enter a title for this item text box, enter: Calendar 

9. Select where to add links to Calendar: 

a. Select On the Course Menu. 

b. Select On an Organizer Page: Homepage. 

Notice that Link shows item title, Link shows icon, and Use default icons are selected 
by default. Leave these items selected so that the link on the Homepage displays the 
title and a default icon. 

10. Click Add. The Homepage appears. Notice that there are now links to Calendar on 
both the Homepage and the Course Menu.  

ADDING ENTRIES TO THE CALENDAR 
You can create Calendar entries that are limited to a brief description of the event, or 
ones that contain more detailed information including event start and end times. You can 
also add links to web sites and WebCT CE course material to the entry.  

You can post Public entries to the calendar that all users can see or Private entries that 
only you can see. By default, students can only post Private entries, but you can allow 
them to post Public entries.  

Note: For more information on allowing students to post Public entries, see the online 
Help topic, Calendar - Customizing Calendar Settings. To access Help, click 
Help on the Menu Bar. 

Now, add two entries to Calendar. The first entry shows the due date of the first 
assignment in your course and the second entry reminds students about a guest lecturer 
speaking on campus. 
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To add the first entry  
Add an entry to the first Monday of next month. You want to tell your students that their 
first assignment is due. 

1. From the Course Menu or Homepage, click Calendar. The Calendar screen appears. 

2. From the Date drop-down lists, select the month and year that corresponds to next 
month, and then click Go. The Calendar screen updates to display next month’s 
calendar. 

3. From the calendar, click the date link that corresponds to the first Monday of the 
month. The View Day screen appears. 

4. Click Add entry. The Add a Calendar Entry screen appears and the date you selected 
is displayed in the Date text boxes. 

5. In the Summary text box, enter: First Assignment Due  

6. Leave the URL and Internal link text boxes empty. You won’t add links to the entry 
for this activity. 

7. In the Detail text box, enter: Your assignment on Discussion Groups 
is due today by 4 p.m. Late assignments will be penalized 
10% per day. 

8. Don’t assign a Start time or an End time. These fields are generally used for events 
that take place over a set period of time. 

9. For Access level, select Public. Public access means that both you and your students 
can see the entry. Private access means that the entry is only visible in your 
Calendar. 

10. Click Add. The View Day screen appears and your entry is displayed. 

 

11. Under the breadcrumbs, click View month. 

 
Click 
View 
month 
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The monthly Calendar view appears and the new entry is displayed in the calendar on 
the first Monday of next month. 

12. To return to the current month’s calendar, click Previous month. 

To add the second entry 
A guest lecturer will be speaking on the latest innovations in the area of wireless Internet 
communications. You want to notify your students. The lecture is scheduled for the 20th 
of the following month. 

1. From the monthly calendar screen, next to the Date drop-down boxes, click Add 
entry.  

 

Click Add entry

The Add a Calendar Entry screen appears. 

2. From the Date drop-down boxes, select the month, day, and year that correspond to 
the 20th of next month.  

3. In the Summary text box, enter: Internet Guest Lecturer on campus 

4. Leave the URL and Internal link text boxes empty. You won’t add links to the entry 
in this activity. 

5. In the Detail text box, enter: An expert on wireless Internet 
communications is speaking tonight in Room 100 in the 
Arts building. 

6. From the Start time drop boxes, select 8:00 p.m. 

7. From the End time drop boxes, select 10:00 p.m. 

8. For Access level, select Public. 

9. Click Add. The Calendar screen appears and your entry is displayed in the calendar 
on the 20th of the month. 
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EDITING A CALENDAR ENTRY 
You can add to or change any of the text fields of a Calendar entry. Now, edit the last 
entry to add a link to the guest lecturer’s website. 

1. From the calendar, click the date link that contains the Internet Guest 
Lecturer on campus entry. The View Day screen appears. 

2. Select the Internet Guest Lecturer on campus entry, and then click 

. The Edit a Calendar Entry screen appears. 

3. In the URL text box, enter: http://www.wirecom.com 

4. Click Update. The entry is updated. 

5. Click View month to return to the main Calendar screen.  

VIEWING THE CALENDAR 
You can view the calendar and its entries in a number of ways. You can view a day at a 
time, a week at a time, or a month at a time. Take a look at these display options now.. 

1. From the calendar, next to Sunday, click View week for the week in which your first 
entry appears.  

 
Click View week 

The View week screen appears. 

2. Click Monday. The View Day screen appears displaying the First Assignment 
due entry. 

Tip: From the View Day and View Week screens, you can also navigate the 
calendar by clicking Previous day/week and Next day/week at the top of the 
screen. 
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3. To return to the monthly calendar, from the breadcrumbs, click Calendar. 

4. To return to the current month, under the breadcrumbs, click Previous month. 

Next, see how the calendar screen appears to your students.  

To preview the new Calendar entries 
 To preview the calendar, click the View tab. 

As you can see, students navigate Calendar in the same way that designers do by clicking 
day, week, or month links. 

You’re finished the activities in this lesson. Go to the next section, Related Activities, or 
the next lesson. 

RELATED AC TIV IT IES 
If you’re interested in learning more about using Calendar, you may want to spend some 
time working through some of the following activities.  

Note: To access the Help Index, click Help on the Menu Bar and then near the top of the 
screen, click Help Index. 

 
To… Go to… 

• compile calendar entries • the online Help topic: Calendar - Compile 
and Download Entries 

• allow students to post public entries 
• change the default instructor access level 

• the online Help topic: Calendar - 
Customize Settings 

• import a text file of calendar entries • the online Help topic: Calendar – 
Importing Entries 

• www.webct.com/exchange. Go to 
the Calendar Zone. 

• add an external or internal link to a 
calendar entry 

• delete calendar entries 

• the online Help topic: Calendar - Add, 
Edit, and Delete Entries 

• clear the calendar • the online Help topic: Calendar - Clear 
Entries 

  

You’re finished Lesson 7:Creating a Course Calendar. In the next lesson, you’ll create   
an online quiz for your students and communicate the quiz grade to each student.  
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LESSON 8: CREATING A QUIZ FOR 
YOUR STUDENTS 

An important part of your course is student evaluation. In a WebCT CE course, you can 
evaluate students using Quizzes/Surveys. 

Quizzes are tests that your students take and submit online. Quiz questions can be 
multiple choice, matching, calculated, short answer, and paragraph questions. All quiz 
questions, except ones in paragraph format, can be automatically graded by the system. 
Those grades can then be returned to your students using Quizzes/Surveys.  

Surveys, which are not covered in this tutorial, are also created using Quizzes/Surveys. 
They are anonymous questionnaires for which no grades are assigned, but which provide 
statistical information. 

For more information on creating a survey, see Quizzes/Surveys in the online Help Index. 
To access the Help Index, click Help on the Menu Bar and then near the top of the screen, 
click Help Index. 

In this lesson, you’ll use Quizzes/Surveys to create a short quiz for your students. 

LEAR NING OBJECTIVES 
After completing this lesson, you’ll be able to: 

• create a link to Quizzes/Surveys on your Course Menu and Homepage. 

• add questions to a database that can be used in quizzes. 

• select questions from the database to create a quiz. 

• assign points to each quiz question. 

• select how and when a quiz is presented to your students and then graded. 

• preview the quiz to see how it appears to your students. 

• communicate quiz grades to your students. 

QUIZ  ACTIV IT IES 
There are six activities in this lesson: 

• adding Quizzes/Survey  to your course 

• creating a multiple choice quiz  

• allocating quiz points so that a quiz score can be generated 
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• specifying quiz settings such as when to make the quiz available to students 

• previewing the quiz 

• adding My Grades to your course so students can view their course grades 

ADDING QUIZ  
First, add Quizzes/Surveys to your course. 

1. Do one of the following: 

• If you’re already logged in to the tutorial course, go to step 4. 

• If you haven’t logged in to the tutorial course, log in. If you need detailed 
instructions, see Logging In on page 7. The myWebCT screen appears. 

2. Click Introduction to Internet Communications. This is the tutorial course that was 
created by your WebCT CE administrator. Depending on whether you’ve logged in 
before, either the Course Design Center appears or the Homepage appears. 

3. Do one of the following: 

• If the Course Design Center appears: 

a. Click Use Course Design Center later. A warning message appears. 

b. Click OK. The Homepage appears. 

• If the Homepage appears, go to step 4. 

4. Click Control Panel. The Basic Control Panel appears. 

5. Click Add Page or Tool. The Add Page or Tool screen appears. 

6. If the Use a wizard when available check box is selected, clear it. You won’t use a 
wizard to add the Quizzes/Surveys tool for this lesson. 

7. Under Evaluation and Activity Tools, click Quizzes/Surveys. The Add 
Quizzes/Surveys screen appears.  

8. For the title, enter: Quiz. 

9. Select where to add links to Quiz: 

a. Select On the Course Menu. 

b. Select On an Organizer Page: Homepage. 

Notice that Link shows item title, Link shows icon, and Use default icons are selected 
by default. Leave these items selected so that the link on the Homepage displays the 
title and a default icon. 

10. Click Add. The Homepage appears. Notice that there are now links to Quiz on both 
the Homepage and the Course Menu.  

 You’ve added Quiz to your course. You’re ready to create a multiple-choice quiz. 
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CREATING A MULTIPLE CHOICE QUIZ 
Creating a multiple-choice quiz consists of six steps: 

1. Create a category in the Question Database. Details appear below. 

2. Add each question to the Question Database category. Details appear below. 

3. Select the question settings. Details appear below. 

4. Enter the possible answers for each question. Details appear below. 

5. Create a quiz. Details appear below. 

6. Add questions to the quiz from the Question Database. Details appear below. 

In this activity, you’ll progress through these six steps to create a short multiple-choice 
quiz that your students can take online. 

To create a Question Database category 
Quiz contains a Question Database. This is the storage area for all quiz questions. All 
new questions must first be added to the database before they can be used in a quiz. 
Questions can be used simultaneously in multiple quizzes.  

As a designer, you create categories to store and organize the questions in the Question 
Database. For example, you may want to group them into categories according to the 
subject matter, course unit, or quiz. In this activity, you’ll group the questions by subject 
matter. The questions are about terminology. 

1. From the Homepage or Course Menu, click Quiz. The Quizzes/Surveys screen 
appears. 

2. Under the breadcrumbs, click Question Database.  

 

The Question Database screen appears. 

3. In the Actions frame, under Options: Category, click Create category. The Create 
Category screen appears. 

4. In the Category title text box, enter: Terminology 

5. Click Create. The Question Database screen appears displaying the new category. 

6. Go to the next procedure to add some questions to the category. 

To add questions to the Question Database 
You can create any of the following types of questions to add to your quiz: multiple-
choice, matching, calculated, short answer, and paragraph.  
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For this lesson, create two multiple-choice questions, one about modems and the other 
about authentication. 

1. From the Question Database screen, in the Actions frame, under Options: Question, 
from the Create question drop-down list, select Multiple choice and click Go. The 
Multiple Choice Question screen appears. 

2. There’s only one category so there’s no need to select a Category from the drop-down 
list.  

3. In the Title text box, enter: Dial-up access 

4. In the Question text box, enter: What is the name of the device that 
allows a computer to transmit data over a standard 
telephone line? 

5. For Format, select HTML. The Format option allows you to select whether to enter 
the question content is in plain text or is formatted with HTML tags. 

6. Leave the Image text box blank. You won’t be adding an image to this question. 

7. Go to the next procedure. 

To select the question settings 
1. On the Multiple Choice Question screen, under Settings, select the following options: 

 
Setting Option 
Allow students to choose One answer 
Scoring Cumulative 
Allow negative score No 
Answer layout Vertical 
Answer order As listed below 
Indices (lists answers in a 
numbered list) Numbers 

 

For a detailed description of each Question setting, click Help on the Menu Bar and 
see the online Help topic, Question Database, “Creating Questions.” 

2. Go to the next procedure. 

To enter the answer choices 
1. In the Answer 1 text box, enter: GUI 

2. For Format, select HTML. 

3. Leave the Value (%) text box empty. This is not the correct answer. 
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4. In the Feedback 1 text box, enter: Incorrect. A Graphical User 
Interface (GUI) incorporates icons, pull-down menus, and 
a mouse into the interface. Microsoft Windows is a GUI. 

5. For Format, select HTML. 

6. To set Answer 2 as the correct answer, select Correct answer. 

7. In the Answer 2 text box, enter: Modem 

8. For Format, select HTML. 

9. Leave the Value (%) text box empty. Since there is only one correct answer, selecting 
Correct answer in step 5 automatically sets Value(%) to 100%.  

Note: If there were two correct answers, use the Value(%) field to assign each 
correct answer a different value. For example, the most important answer 
could generate 70% of the question’s points while the less important answer 
would generate 30%. 

10. In the Feedback 2 text box, enter: Correct. A Modulator-Demodulator 
converts digital pulses from a computer to audio tones 
that are transmittable by a telephone line. 

11. For Format, select HTML. 

Your screen should look like this: 

 

12.  In the Answer 3 text box, enter: Port 
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13. For Format, select HTML. 

14. Leave the Value (%) text box empty. 

15. In the Feedback text box, enter: Incorrect. A port is a pathway into 
and out of a computer for plugging in printers, modems, 
and communication lines.  

16. For Format, select HTML. 

17. You’re finished entering answer choices. Scroll to the bottom of the screen and click 
Save. The Question Database screen appears. 

 

The question, Dial-up access is added to the database in the category, 
Terminology. The Type column indicates that it’s a multiple-choice question. 

18. Now, add another question and answer set under Terminology by repeating the 
previous three activities using the following information: 

Title: Log in 

Question: What process occurs when you enter your 
email username and password? 

Answers: 1. Authorization 

2. Validation 

3. Authentication 

Set answer 3 as the correct answer. 

Feedback: 1. Incorrect 

2. Incorrect 

3. Correct. Authentication is the process 
of verifying the identity of a user 
who is logging in to a computer 
system. 
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Your Question Database screen should look now like this: 

 

19. Go to the next procedure to create a quiz. 

To add a quiz  
Now, create an empty quiz and name it. You’ll add questions from the Question 
Database in the next activity. 

1. From the Question Database screen, under the breadcrumbs, click Quizzes/Surveys.  

 

Click Quizzes/Surveys

The Quizzes/Surveys screen appears. 

2. In the Actions frame, under Options, click Create quiz. The Create Quiz screen 
appears. 

3. In the Title text box, enter: Quiz 1. 

4. Click Create. The Quizzes/Surveys screen appears displaying Quiz 1. 
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Results options

Tip: Once your students have taken the quiz you can grade questions or view the 
quiz results individually or as statistical data using the Results options: 
Submissions, Detail, Reports, and Summary.  

Go to the next procedure to add the questions to Quiz 1. Students can only access 
questions that are added to a quiz.  

To add questions to the quiz 
Now, add the questions from the Question Database to Quiz 1. 

1. From the Quizzes/Surveys screen, click Quiz 1. The Quiz Editor screen appears. 

2. In the Actions frame, under Options, click Add questions. The Question Browser 
window appears. 

3. In the table under Name, click Terminology to open the folder. The questions you 
created, Dial-up access and Log in, appear. 

 

Click to 
select all 
questions 
in the 
category 

Tip: To preview a question, click . 

4. To select all questions in the category, select Terminology. 

5. Click Add selected at the bottom of the screen. The Quiz Editor screen appears and 
the questions are added to Quiz 1. 

Next, assign points to each question. 

ALLOCATING POINTS 
You assign point values to questions once they’re added to a quiz. This means that you 
can assign different point values to a question in different quizzes 
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Now, allocate the points for each question. The quiz is worth a total of 20 points, with 
each question valued at 10 points.  

1. From the Quiz Editor screen, in the Points column, in each of the text boxes, enter: 
10 

2. Click Update total. The Total now shows 20. 

 

The quiz is created. Next, select how and when the quiz is presented to your students. 

SELECTING QUIZ SETTINGS 
Using Quiz Settings, you can specify, for example, which students receive the quiz, how 
long they have to complete it, how many attempts are allowed, and how the results are 
released to them. There are numerous settings available on the Quiz Settings screen. For 
this tutorial, you’ll select Basic, Availability, and Results settings only. 

For more information about using other Quiz Settings, see the online Help topic, 
Quizzes/Surveys- Editing. Go to the section, Editing Quiz settings. To access the online 
Help, click Help on the Menu Bar. 

1. From the Quiz Editor screen, in the Actions frame, under Options, click Edit quiz 
settings. The Quiz Settings screen appears. 

2. Select the following Basic Settings: 

For this Setting… Do this… 
Quiz title Verify that Quiz 1 is displayed. 

Question titles Do not select Show the question titles when students 
view the quiz. 

Question delivery Select Deliver all the questions at once. 

Quiz duration Enter: 30 and select minutes from the drop-down list. 

Attempts allowed Select 1.  

Attempts separation Leave blank. 
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3. Under Availability, next to the Available after drop-down boxes, click Allow access 
now.  

4. For Available until, from the drop-down boxes, select the month, day, year, and time 
that corresponds to 24 hours from now.  

5. Scroll down to the Results section, and under Student score release, select Release the 
score once the availability period has ended. This means that students are able to 
view their grade in Quiz once the quiz is no longer available and the quizzes are 
graded. 

Tip: You can also communicate quiz grades to your students using My Grades. My 
Grades allows students to view their course grades confidentially and online. 
You’ll learn more about this tool and add it to your course in the next activity. For 
now, release the quiz to My Grades. 

6. Under Release column, select Yes. 

7. Leave all other settings as is. 

8. Click Update. The Quiz Editor screen appears and the quiz is now available for your 
students to complete.  

Next, see how the quiz appears to your students. 

PREVIEWING THE QUIZ 
Now that you’re finished creating the quiz, you can preview it from the Quiz Editor 
screen. 

1. In the Actions frame, under Options, click Preview quiz. A new browser window 
opens and the quiz appears as it would to a student. 

2. Close the browser window. The Quiz Editor screen appears. 

 

You’re finished the Quiz activities. In the next activity, you’ll add My Grades to your 
course to allow students to view their grade for Quiz 1. 

COMMUNICATING THE QUIZ GRADE TO YOUR STUDENTS 
In the activity, Selecting the Quiz Settings, you released grades to students in two places: 
Quizzes/Surveys and My Grades. Student can use Quizzes/Surveys to view their score 
once the quiz is graded. They can also view their quiz score using My Grades. Students 
can view their own Assignment, Quiz, midterm, and final grades on this screen. My 
Grades is for students use only. As a designer, you must use Manage Students to view 
student grades.  

Quiz grades are automatically released to My Grades once the quizzes are graded. For 
other grades, such as midterm and final grades, you must enter them manually using 
Manage Students. From this screen, you select which grades to release to My Grades.  

77 



For more information on assigning, viewing, and releasing grades, see the online Help 
topic, Manage Students – Student Records. To access the online Help, click Help on the 
Menu Bar. 

Now, add My Grades to your course so students can view their course grades. 

To add My Grades 
1. Click Control Panel. The Basic Control Panel appears.  

2. Click Add Page or Tool. The Add Page or Tool screen appears. 

3. Under Student Tools, click My Grades. The Add My Grades screen appears. 

4. For the title, enter: My Grades 

5. Select where to add links to My Grades: 

a. Select On the Course Menu. 

b. Select On an Organizer Page: Homepage. 

Notice that Link shows item title, Link shows icon, and Use default icon are selected 
by default. Leave these items selected so that the link on the Homepage displays the 
title and a default icon. 

6. Click Add. The Homepage appears. Notice that there are now links to My Grades on 
both the Homepage and the Course Menu. 

To grade the quiz 
Because no students have taken Quiz 1, you can’t request that the quiz submissions be 
graded. However, in the course you create at your institution, you would use 
Submissions, from the Quizzes/Surveys screen or the Quiz Editor screen, to generate the 
quiz results.  

 
 Select Submissions   Click Grade

From the Submissions screen, you would select the submissions that you want to grade 
and then in the Actions frame, under Options, you’d click Grade. The quiz results are 
then automatically added to My Grades. At that time, students can access 
Quizzes/Surveys or My Grades to view their results. 

For more information on grading quizzes, see the online Help topic, Quizzes/Surveys – 
Grading Quizzes. To access Help, click Help on the Menu Bar. 
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You’re finished the activities in this lesson 

RELATED AC TIV IT IES 
If you’re interesting in exploring the Quizzes/Surveys options further, you may want to 
spend some time working through some of the following activities. 

Note: To access the Help Index, click Help on the Menu Bar and then near the top of the 
screen, click Help Index. 

 
To… Go to… 

• add a short answer question 
• add a paragraph question 
• add a calculated question 
• add a matching question 
• move or delete a question 

• the online Help topic: Quizzes/Surveys – 
Question Database 

 
 
 

• import or download a question set • the online Help topic: Quizzes/Surveys – 
Importing and Downloading Questions 

• manually grade a quiz 
• override a question score 
• assign bonus or penalty points  

• the online Help topic: Quizzes/Surveys – 
Grading Quizzes 

• view quiz details, summaries, statistics, 
and reports 

• the online Help topic: Quizzes/Surveys – 
Details, Statistics, and Reports 

• learn about other tools and tricks to help 
you create quizzes and surveys 

• www.webct.com/exchange. Go to 
the Quiz Zone 

  

You’re finished Lesson 8: Creating a Quiz for Your Students. 

If you’ve worked through the lessons sequentially you’ve also finished the tutorial. 
Congratulations! You’re now ready to create a course to use at your institution.  

Additional resources, help, and information for designers can be found in the online Help 
or on the WebCT website. Appendix B: Resources Available Through WebCT.com on 
page 85 lists the resources that you’ll find particularly helpful. 

79 

http://www.webct.com/exchange


APPENDIX  

APPENDIX  A:  WEBCT COURSE TOOLS 
The table below describes the WebCT course elements that you can add to your course. 
Review the list during the planning phase of building your course to determine which 
course elements you want to use. The elements are grouped into the following tasks: 

• Adding course content 

• Communicating with your students and teaching assistants 

• Evaluating your students 

• Managing your course 

• Enriching the student experience 

• Adding features to a content module to assist students  

To add course content 

Course 
Element 

Where you 
can add the 
link  

Description 

Content Module Homepage 
Organizer Page 
Course Menu 

Allows the designer to organize a collection of related 
documents in a table of contents with built-in navigation 
links and study tools. This is the main area where students 
view course material. 

CD ROM Homepage 
Organizer Page 
Course Menu 

Allows students to access multimedia files from a content 
module that are stored on a CD-ROM. By clicking a link 
in Content Module, the CD-ROM tool reads the file from 
the student’s local CD_ROM drive.  

Glossary Homepage 
Organizer Page 
Course Menu 

Allows the designer to create a list of words and their 
definitions that are related to the course. You can also 
access the glossary definition of a word by clicking the 
keyword link within a page of content. 

Image 
Database 

Homepage 
Organizer Page 
Course Menu 

Allows the designer to store images in a searchable 
archive that students can access.  

 

 

80 



To add course content continued 
Course 
Element 

Where you 
can add the 
link  

Description 

Single Page Homepage 
Organizer Page 
Course Menu 

Allows the designer to present supplementary or optional 
course material that is not included in a Content Module. 

Syllabus Homepage 
Organizer Page 
Course Menu 

Allows the designer to upload an existing course syllabus 
from their computer to their WebCT course or to create a 
new syllabus  

URL Homepage 
Organizer Page 
Course Menu 

Allows the designer to add a link to a local file or an 
external Uniform Resource Locator (URL). 

 
To communicate with your students and teaching assistants 
Course 
Element 

Where you 
can add the 
link  

Description 

Calendar Homepage 
Organizer Page 
Course Menu 

Allows users to exchange information about class events. 
Information can be made public or private. 

Chat Homepage 
Organizer Page 
Course Menu 

Allows users to have real-time conversations with all 
users logged in on the same server. It can be used for 
online interactive sessions such as tutorials and 
discussions. 

Discussions Homepage 
Organizer Page 
Course Menu 

Allows users to engage in online discussions within pre-
defined topic areas. Users post and reply to messages at 
their convenience. 

Mail Homepage 
Organizer Page 
Course Menu 

Allows users to send private messages, with or without 
attachments, to other users within a course. 

Whiteboard Homepage 
Organizer Page 
Course Menu 

Allows users to communicate with other logged in users 
by entering text, drawing objects, inserting graphics, and 
making image modifications online and in real-time.  
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To evaluate your students 
Course 
Element 

Where you 
can add the 
link  

Description 

Assignments Homepage 
Organizer Page 
Course Menu 

Allows the designer to distribute course assignments to 
students.  Features include assignment description, 
maximum grade value, a utility for attaching files that are 
related to the assignment, and student submission of 
completed assignments. 

Quizzes/Surveys Homepage 
Organizer Page 
Course Menu 

Allows the designer to create quizzes and surveys that 
students take online. Depending on the type of questions, 
a quiz can be graded automatically by WebCT and the 
result communicated to the student. Surveys are submitted 
anonymously and WebCT compiles the statistics. 

Self-Test Homepage 
Organizer Page 
Course Menu 

Allows the designer to create multiple-choice review 
questions with immediate feedback. They are not viewed 
by the instructor and are not graded. 

 
To manage your course  

Course 
Element 

Where you 
can add the 
link  

Description 

Compile Homepage 
Organizer Page 
Course Menu 

Allows users to gather several pages from a content 
module into one file for viewing or printing. 

Index Homepage 
Organizer Page 
Course Menu 

Allows students to search the content module for specific 
information. Designers enter index entries and subentries. 
The Index lists them alphabetically with links to the 
corresponding content page. 

Language 
Selector 

Homepage 
Organizer Page 
Course Menu 

Allows users to select the language in which to display 
WebCT. Add this tool if multiple languages are available 
in your course.  

Organizer Page Homepage 
Course Menu 

Allows the designer to group the links of related WebCT 
tools together on one page. For example, all 
communication tools can be grouped together on one 
Organizer Page. 

Search Homepage 
Organizer Page 
Course Menu 

Allows users to search for specific information within the 
index, titles, headings, and content of a course. 
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To enrich the student experience 

Course 
Element 

Where you 
can add the 
link  

Description 

My Grades Homepage 
Organizer Page 
Course Menu 

Allows a student to view his or her own grades as entered 
by the instructor or teaching assistant. When enabled by 
the designer, students can see the class statistics for a quiz 
or assignment as well. 

My Progress Homepage 
Organizer Page 
Course Menu 

Allows students to view a history of the pages they have 
visited and the number of times visited. 

Student Tips 
 

Homepage 
Organizer Page 
Course Menu 

Allows the designer to create tips or hints for students in a 
course. These tips display randomly each time a student 
logs in to the course. Students can control whether or not 
they see the Student Tip of the Day. 

Resume Course Homepage 
Organizer Page 
Course Menu 
Menu Bar 

Upon entering a course, this tool allows students to return 
to the last Content Module content page accessed from the 
previous WebCT session. 

Student 
Presentations 

Homepage 
Organizer Page 
Course Menu 

Provides individual students, or a group of students, with 
authoring privileges so they can upload web pages for 
viewing by the instructor and class. 

Student 
Homepages 

Homepage 
Organizer Page 
Course Menu 

Allows students to create their own home page within a 
course. This tool encourages students to share what they 
know and assists in creating a collaborative learning 
community. 

 
To add features to a content module to assist students 

Course 
Element 

Where you 
can add the 
link  

Description 

Audio Action Menu Allows the designer to add audio clips to a content page in 
a content module. 

Bookmarks Action Menu Allows users to bookmark pages within a content module. 

Chat Action Menu Allows users to have real-time conversations with all 
users logged in on the same server. It can be used for 
online interactive sessions such as tutorials and 
discussions 
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To add features to a content module to assist students continued 

Course 
Element 

Where you 
can add the 
link  

Description 

Discussions Action Menu Allows users to engage in online discussions within pre-
defined topic areas. Users post messages and reply to 
messages at their convenience. 

Glossary Action Menu 

Allows the designer to create a list of words and their 
definitions that are related to the course. The glossary 
definition of a word can also be accessed by clicking the 
keyword link within a page of content. 

Goals Action Menu Allows the designer to post the learning goals for a page 
of content. 

Index Action Menu 

Allows students to search the content module for specific 
information. Designers enter index entries and subentries. 
The Index lists them alphabetically with links to the 
corresponding content page. 

Links Action Menu 
Allows the designer to add a link to either a local file or 
an external Uniform Resource Locator (URL) from a 
content module. 

Mail Action Menu Allows users to send private messages, with or without 
attachments, to other users within a course 

Quizzes/Surveys Action Menu 

Quizzes/Surveys – Allows the designer to create quizzes 
and surveys that students take online. Depending on the 
type of questions, a quiz can be graded automatically by 
WebCT and the result communicated to the student. 
Surveys are submitted anonymously and WebCT 
compiles the statistics. 

References Action Menu 
References - Allows the designer to direct students to 
supplementary information sources, which can be 
textbooks, articles, or URLs. 

Search Action Menu 
Search - Allows student and designer to locate specific 
information within the index, titles, headings, or text of a 
course. 

Self-Test Action Menu  

Self-Test - Allows the designer to create multiple-choice 
review questions. Students take a self-test online and are 
provided with immediate feedback. Self-tests are not 
viewed by the instructor and are not graded. 

Take Notes Action Menu 
Take Notes - Allows students to add notes or journal 
entries to a specific content page. Only the student who 
entered the note can view it. 

Video Action Menu Video - Allows the designer to add video clips to a 
content page in a content module. 
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APPENDIX  B:  RESOUR CES AVAILA BLE 
THROUGH WEBCT.COM 
The WebCT website contains numerous resources to help faculty use WebCT CE to 
enhance their teaching experience. The following is a list of resources available on 
http://www.webct.com/that may be of particular interest to new designers.  

Getting Started with WebCT 
http://www.webct.com/quickstart 

Contains resources for all versions of WebCT's software for faculty and course designers 
who are looking for information on how to use WebCT. 
  

WebCT Faculty Resources 
http://www.webct.com/faculty 

Contains resources and help for faculty teaching online with WebCT. 
  

WebCT Community Resources 
http://www.webct.com/wyw 

Contains links to a wealth of information about WebCT. 
  

WebCT Course Content  
http://www.webct.com/content 

Contains information about e-Learning Resource Packs. e-Packs are course content 
packages created for use with WebCT by leading publishers in the education field. They 
are customizable online course materials to which you can add your own resources or use 
as a stand-alone unit that provides an online component to your classroom-based course.  
  

Academic Subject Resources 
http://www.webct.com/subject 

Contains resources in over 70 subject areas, enabling faculty and students to share course 
materials, content, experiences, and ideas. 
  

Ask Dr. C 
http://www.webct.com/ask_drc 

Contains a question-and-answer service moderated by a dedicated, international 
community of experienced WebCT users who will answer questions about using WebCT. 
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WebCT Online Workshops  
http://www.webct.com/workshops 

Contains information about the full range of introductory and advanced workshops for 
both faculty and staff offered by WebCT. 
 

WebCT Support 
http://www.webct.com/support 

Contains resources and help to resolve any technical difficulties encountered in WebCT. 
The page also contains links to frequently asked questions, support bulletins, and a 
Support Knowledge Base. 
 

WebCT Newsletter 
http://www.webct.com/newsletter 

Contains information about the WebCT Newsletter, a free electronic publication 
featuring information of interest to Web-based educators and WebCT users. Published 
monthly, the newsletter keeps users informed of the latest WebCT company, product, and 
customer news.  

The WebCT Newsletter is delivered through e-mail announcements; subscription is free. 
Subscriptions for the newsletter are managed online at 
http://www.webct.com/communities/service/selectnewsletters 
 

WebCT eXchange 
http://www.webct.com/exchange 

Contains ideas, tools, tricks and accomplishments shared by WebCT users. There are 
links to WebCT compatible tools created by users and an area to showcase actual WebCT 
courses.  
 

WebCT Exemplary Course Project 
http://www.webct.com/exemplary 

Contains a showcase of those WebCT courses that have been chosen by the project as 
exemplary in terms of the implementation of best practices and the creative use of 
technology. 
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INDEX 

A 

Action Menu 
adding items to, 46 
description of, 46 

Actions frame, description of, 14 

B 

breadcrumbs, 9, 10 
browser settings, enabling Java, 56 

C 

Calendar, 62–67 
adding entries to, 63 
editing entries in, 66 
entries, public vs. private, 63 
viewing, 66 

Chat, 56–61 
adding a textblock, 58 
Entry Chime, 59 
logs, viewing, 60 
rooms, 58 
sending messages, 59 

Check Browser, 10 
color, changing on Homepage, 23 
Content Module, 36–48 

Action Menu. See Action Menu 
adding content to, 42 
organizing the Table of Contents, 43–

45 
updating student view, 47 

Control Panel 
Basic, 13 
description of, 12 
Expanded, 13 

course 
adding content to, 42 
adding tools to, 26 
logging in to, 7 
navigating, 14 
planning of, 15–18 

Course Design Center, 21 
Course Map, 10 
Course Menu 

description of, 11 
hiding, 12 

D 

Designer Options tab. See tabs 
Discussions, 50–55 

creating topics in, 52 
replying to messages, 54 
sending messages in, 53 
viewing messages, 54 

E 

edit 
file, 32 
link, 38 

Entry Chime, 59 

F 

file formats, 28 
files 

downloading for tutorial, 28 
editing in WebCT, 32 
unzipping, 29 
uploading, 6, 28 

H 

heading, adding to Homepage, 20 
Help, accessing online, 11 
Homepage, 20–25 

adding a textblock, 20 
changing the color scheme, 23 
description of, 8 

HTML Editor, 33 

J 

Java, enabling in browser, 56 
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L 

links 
changing appearance of, 38 
definition, 5–6 
displaying on the Homepage or 

Course Menu, 12 
editing, 38 

logging in, 7 

M 

Mail, 50 
Manage Files 

description of, 28 
editing a file with, 32 
unzipping files in, 29 
uploading files to, 28 

Menu Bar, description of, 9 
messages 

replying to in Discussions, 54 
sending in Chat, 59 
sending in Discussions, 53 
thread of, 53, 55 
viewing in Discussions, 54 

My Grades, 77 

N 

navigation, 14 

O 

Organizer Pages, 8 

P 

planning an online course, 15–18 

Q 

Question Database, 70–74 
adding answers to, 71 
adding questions to, 70 
creating a category in, 70 
question settings, 71 

Quizzes, 68–79 
adding questions to, 75 
adding to course, 74 
allocating points, 75 

creating multiple-choice, 70 
grading, 78 
previewing, 77 
Question Database. See Question 

Database 
releasing grades, 77 
settings, 76 
submissions, 78 

Quizzes/Surveys. See Quizzes or see 
Surveys 

S 

server, WebCT, 5 
settings 

browser, 56 
question, 71 
quiz, 76 

Surveys, 68 
Syllabus, 26–35 

adding to course, 31 
editing, 32 

T 

Table of Contents. See Content Module 
tabs 

Designer Options, 10, 11 
location of, 9 
switching, 11 
View, 10, 11 

Take Notes, adding to Action Menu, 46 
textblocks 

adding to Chat, 58 
adding to Homepage, 20 

thread. See messages 
tools 

adding to course, 26 
definition, 7 

tutorial 
adding sample files to course, 27 
administrator tasks, 2 
audience, 2 
requirements, 2 
using, 3 
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U 

unzipping files, 29 

V 

View tab. See tabs 

W 

WebCT CE 

about, 1 
environment, 8–14 
loggin in to, 7 
navigation of, 14 
terminlogy, 5–7 

WebCT server, 5 
uploading files to, 28 

Whiteboard, 50 
wizards. See Course Design Center 
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